Event Capture System (ECS)
Graphical User Interface

User’s Manual

Software Version 2.0
Patch EC*2.0*131

September 2016
Document Version 1.1

Department of Veterans Affairs
Office of Information and Technology
Product Development
## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/19/2016</td>
<td>v1.1</td>
<td>Incorporated MCAO feedback and revisions</td>
<td>TeamSMS/LMCO</td>
</tr>
<tr>
<td>06/30/2016</td>
<td>v1.0</td>
<td>Initial Document Release</td>
<td>TeamSMS/LMCO</td>
</tr>
</tbody>
</table>
# Table of Contents

1 Introduction ................................................................................................. 1  
  1.1 Purpose ...................................................................................................... 1  
  1.2 Document Orientation .............................................................................. 1  
    1.2.1 Organization of the Manual ................................................................. 1  
    1.2.2 Assumptions ....................................................................................... 1  
    1.2.3 Disclaimers ......................................................................................... 2  
      1.2.3.1 Software Disclaimer ...................................................................... 2  
      1.2.3.2 Documentation Disclaimer ............................................................ 2  
    1.2.4 Documentation Conventions ............................................................... 2  
    1.2.5 References and Resources .................................................................... 2  
  1.3 National Service Desk and Organizational Contacts ............................... 3  

2 System Summary ........................................................................................... 4  
  2.1 System Configuration ............................................................................... 4  
  2.2 Data Flows ............................................................................................... 4  
  2.3 User Access Levels .................................................................................. 4  
  2.4 Continuity of Operations ....................................................................... 5  
  2.5 Section 508 Compliance ....................................................................... 5  

3 Getting Started ............................................................................................. 6  
  3.1 Logging On ............................................................................................... 7  
  3.2 Event Capture Main Menu ...................................................................... 8  
    3.2.1 Icon Shortcuts ..................................................................................... 9  
    3.2.2 Menu Bar .......................................................................................... 10  
  3.3 Menu Bar for Specific Functions ............................................................ 10  
    3.3.1 Data Entry Menu Bar ...................................................................... 10  
    3.3.2 Spreadsheet Menu Bar ..................................................................... 11  
    3.3.3 Reports Menu Bar .......................................................................... 12  
    3.3.4 Management Menu Bars ................................................................. 12  
  3.4 Changing User ID and Password ............................................................ 13  
  3.5 Exit System ............................................................................................ 13  
  3.6 Caveats and Exceptions ......................................................................... 13  
  3.7 Online Documentation .......................................................................... 13  
  3.8 Event Capture Interface with CPRS ...................................................... 14  
  3.9 Timeout Feature ................................................................................... 14  
  3.10 CCOW Single Sign On ......................................................................... 15  

4 Using the Software ....................................................................................... 16  
  4.1 Data Entry Menu .................................................................................... 16  
    4.1.1 Data Entry by Patient ....................................................................... 16  
    4.1.1.1 Recent Visits Screen ...................................................................... 19
4.1.1.2 Add Information to the Add Patient Procedure or Edit Patient Procedure Screen ........................................... 22
4.1.1.3 Add a Patient Procedure................................................................................................................................. 24
4.1.1.4 Edit a Patient Procedure................................................................................................................................... 27
4.1.1.5 Delete a Patient Procedure ............................................................................................................................... 29
4.1.2 Data Entry by Procedure ........................................................................................................................................ 31
4.1.2.1 Add a Procedure for Multiple Patients ............................................................................................................... 32
4.1.3 Multiple Dates / Multiple Procedures .................................................................................................................. 36
4.1.3.1 Instructions for Common Fields .......................................................................................................................... 37
4.1.3.2 Add Information to Providers Tab......................................................................................................................... 38
4.1.3.3 Add Information to Procedures Tab....................................................................................................................... 39
4.1.3.4 Add Information to Select Patient Tab .................................................................................................................. 41
4.1.3.5 Verify Information Using the View Selected Patients Tab .................................................................................. 43
4.1.3.6 Verify Information Using the Records Pending Filing Tab .................................................................................. 45

4.2 Spreadsheet ......................................................................................................................................................... 47
4.2.1 Import a Regular Spreadsheet ............................................................................................................................ 47
4.2.2 Data Imported and Ready for Upload ................................................................................................................... 48
4.2.3 Edit Cell Data on the Spreadsheet Upload Form .................................................................................................. 49
4.2.4 Modify Column Order ............................................................................................................................................ 49
4.2.5 Upload Imported Spreadsheet Data..................................................................................................................... 51
4.2.5.1 Spreadsheet Column Errors .............................................................................................................................. 51
4.2.5.2 Service Connected Questions Validation ........................................................................................................... 54
4.2.5.3 Other Error Correction Logic ............................................................................................................................ 54
4.2.5.4 Duplicate Record Errors ..................................................................................................................................... 55
4.2.6 Import a State Home Spreadsheet ........................................................................................................................ 55
4.2.7 Upload Completion .................................................................................................................................................. 57

4.3 Reports ................................................................................................................................................................. 57
4.3.1 Reports Available to All Users .............................................................................................................................. 57
4.3.1.1 DSS Unit Activity Report .................................................................................................................................. 58
4.3.1.2 DSS Unit Workload Report ................................................................................................................................ 60
4.3.1.3 ECS Records Failing Transmission to PCE Report ............................................................................................ 61
4.3.1.4 Event Capture Encounters Report ...................................................................................................................... 63
4.3.1.5 Ordering Section Summary Report .................................................................................................................... 66
4.3.1.6 Patient Summary Report ................................................................................................................................... 67
4.3.1.7 PCE Data Summary Report .................................................................................................................................. 71
4.3.1.8 Procedure Reasons Report .................................................................................................................................... 73
4.3.1.9 Provider Summary Report ...................................................................................................................................... 75
4.3.1.10 Provider (1-7) Summary Report .......................................................................................................................... 76
4.3.2 Reports Available to ECMGR Key Holders Only ............................................................................................... 78
4.3.2.1 Category Report ................................................................................................................................................. 79
4.3.2.2 Disabled Category and Procedure Summary ......................................................................................................... 82
4.3.2.3 DSS Units with Any Associated Stop Code Errors Report ................................................................................. 84
4.3.2.4 DSS Units/Event Code (EC) Screens for Selected Procedure Code Report .......................................................... 86
4.3.2.5 DSS Unit User Access Report ............................................................................................................................ 88
4.3.2.6 Event Code Screens with CPT Codes Report ....................................................................................................... 89
4.3.2.7 Event Code Screens with Inactive Default Associated Clinic Report .............................................................. 91
4.3.2.8 Inactive Person Class Report (IPC) Report ............................................................................................................. 92
4.3.2.9 National/Local Procedure Codes with Inactive CPT Codes Report ................................................................. 94
4.3.2.10 National/Local Procedure Report – Active Procedures ........................................ 96
4.3.2.11 National/Local Procedure Report – Inactive Procedures ..................................... 97
4.3.2.12 Print Category and Procedure Summary (Report) ............................................... 99
4.3.2.13 Send No Records DSS Units Report .................................................................... 101

4.4 Management Menu ........................................................................................................... 103
4.4.1 Location – Update Location Information ...................................................................... 104
4.4.2 DSS Unit – Add or Update DSS Units ......................................................................... 106
  4.4.2.1 Add a DSS Unit ....................................................................................................... 109
  4.4.2.2 Update a DSS Unit ................................................................................................. 110
  4.4.2.3 To Grant Access to a DSS Unit .............................................................................. 110
  4.4.2.4 To Disable Categories for a DSS Unit .................................................................. 111
4.4.3 Access by User - Grant Access to DSS Units by User .................................................. 113
  4.4.3.1 To Assign User Access to DSS Units ................................................................... 114
  4.4.4 Category - Add or Update Categories ...................................................................... 115
    4.4.4.1 To Add or Update Categories .......................................................................... 115
4.4.5 Procedure - Add or Update Local Procedures ............................................................... 116
4.4.6 Reason - Add or Update Procedure Reasons ............................................................... 120
  4.4.6.1 Activate Reasons .................................................................................................. 121
  4.4.6.2 Inactivate Reasons ............................................................................................... 122
  4.4.6.3 Add a New Reason ............................................................................................... 123
4.4.7 Event Code Screen: Add, Update, or Copy Event Code Screens .................................... 123
  4.4.7.1 Setting a DSS Unit to Send Data to PCE ............................................................... 126
  4.4.7.2 Inactivate EC Screen: Identify Inactive Multiple Event Code Screens .................. 130

5 Troubleshooting ..................................................................................................................... 133
5.1 Access Issues ..................................................................................................................... 133
5.2 Log On Issues .................................................................................................................... 133
5.3 GUI Appears Distorted ..................................................................................................... 133
  5.3.1 Example of Setting the Screen Resolution to 1600 x 900 ......................................... 133

Appendix A: Acronyms .......................................................................................................... 135
Appendix B: Glossary ............................................................................................................. 137
Appendix E: Other ECS Package Management Information .............................................. 139
Appendix F: Index ................................................................................................................... 143

List of Tables

Table 1. Tier Support Contact Information ............................................................................. 3
Table 2. Element Name and Description ................................................................................. 108

List of Figures
Figure 1: ECS Data Flow Diagram ................................................................. 4
Figure 2: ECS GUI Icon .............................................................................. 7
Figure 3: VistA Sign-on Screen ................................................................. 8
Figure 4: Main Menu for Event Capture .................................................. 9
Figure 5: Main Menu with the ECNORPT Security Key Added for the User .... 9
Figure 6: Icon Shortcuts ............................................................................ 10
Figure 7: Main Menu Bar .......................................................................... 10
Figure 8: Main Menu Bar with Menus Expanded .................................... 10
Figure 9: Data Entry Menu Options .......................................................... 11
Figure 10: Data Entry with Menus Expanded ........................................... 11
Figure 11: Spreadsheet Upload Options .................................................... 11
Figure 12: Spreadsheet Menu with Menus Expanded .............................. 12
Figure 13: Reports Menu Bar .................................................................. 12
Figure 14: Reports Menu with Menus Expanded .................................... 12
Figure 15: Management Menu Options .................................................... 12
Figure 16: Management Menu with Menus Expanded ............................ 13
Figure 17: Online Help Screen .................................................................. 14
Figure 18: Event Capture Timeout Screen .............................................. 14
Figure 19: Event Capture CCOW Status .................................................... 15
Figure 20: Data Entry Menu Screen ......................................................... 16
Figure 21: Enter/Edit Patient Procedures Screen .................................... 17
Figure 22: Calendar Dropdown for Date Range View ............................... 18
Figure 23: Procedure History for Sample Patient .................................... 19
Figure 24: Recent Visits Screen ............................................................... 20
Figure 25: Error: Invalid Associated Clinic Message Dialog .................... 21
Figure 26: Add Patient Procedure Detail Screen ..................................... 21
Figure 27: Select Date/Time Dialog Box .................................................... 22
Figure 28: Service Connection and Rated Disabilities Screen .................. 23
Figure 29: Enter/Edit Patient Procedures Screen .................................... 25
Figure 30: Recent Visits Screen ............................................................... 25
Figure 31: Add Patient Procedure Screen ................................................ 26
Figure 32: Enter/Edit Patient Procedures with New Procedure Added ....... 27
Figure 33: Enter/Edit Patient Procedures Screen .................................... 28
Figure 34: Edit Patient Procedure Screen ................................................ 29
Figure 35: Enter/Edit Patient Procedures Screen ................................................................. 30
Figure 36: Procedure Deleted Confirmation Dialog .......................................................... 30
Figure 37: Confirmation Message ...................................................................................... 31
Figure 38: Enter/Edit Patient Procedures Screen with Procedure Deleted ......................... 31
Figure 39: Same Procedure, Multiple Patients Screen ......................................................... 32
Figure 40: Select Date/Time Dialog .................................................................................. 33
Figure 41: Service Connection and Rated Disabilities Dialog ............................................ 35
Figure 42: View Patients for this Procedure Screen .......................................................... 36
Figure 43: Multiple Dates/Multiple Procedures Screen – Initial Screen ............................... 37
Figure 44: Select Date/Time Dialog .................................................................................. 38
Figure 45: Multiple Dates/Multiple Procedures Screen, Providers Tab ............................ 39
Figure 46: Multiple Dates/Multiple Procedures Screen, Procedures Tab ......................... 40
Figure 47: View Procedure Record Details Screen ........................................................... 41
Figure 48: Multiple Dates/Multiple Procedures Screen, Select Patient Tab ...................... 42
Figure 49: Service Connection and Rated Disabilities Dialog ........................................... 43
Figure 50: Multiple Dates/Multiple Procedures View Selected Patients Tab ..................... 44
Figure 51: Deleting Patient Confirmation Dialog ............................................................ 44
Figure 52: View Patient Record Details Screen ............................................................... 45
Figure 53: Multiple Dates/Multiple Procedures Records Pending Filing Tab ..................... 46
Figure 54: Information Dialog after Saving ...................................................................... 46
Figure 55: Spreadsheet Upload Screen ............................................................................ 47
Figure 56: Select File Dialog - Open a Spreadsheet ........................................................... 48
Figure 57: Imported Spreadsheet Data Shown in the Spreadsheet Upload Form ................ 49
Figure 58: Column Headers Form .................................................................................... 50
Figure 59: Connected Error Message and Export SC Errors Button ............................... 54
Figure 60: Export SC Errors Spreadsheet ....................................................................... 54
Figure 61: Duplicate Record Threshold Reached Screen .................................................. 55
Figure 62: Select File Dialog - Open a State Home Spreadsheet ...................................... 56
Figure 63: Additional Data Form for State Home Spreadsheet Import .............................. 56
Figure 64: Spreadsheet Upload Progress Indicator ............................................................ 57
Figure 65: Report Selection Screen for All Users .............................................................. 58
Figure 66: DSS Unit Activity Report Required Information .............................................. 59
Figure 67: DSS Unit Activity Report from Print Preview .................................................... 59
Figure 68: DSS Unit Activity Report from Export ............................................................. 60
Figure 69: Required Information for DSS Unit Workload Report ........................................... 60
Figure 70: DSS Unit Workload Report from Print Preview .................................................... 61
Figure 71: DSS Unit Workload Report from Export ............................................................... 61
Figure 72: ECS Records Failing Transmission to PCE Report Required Fields..................... 62
Figure 73: ECS Records Failing Transmission to PCE Report from Print Preview ................... 62
Figure 74: ECS Records Failing Transmission to PCE Report from Export .......................... 63
Figure 75: Event Capture Encounters Report Required Fields .............................................. 64
Figure 76: Event Capture Encounters Report Timeout Warning .............................................. 64
Figure 77: Event Capture Encounters Report Sorted by Patient ............................................. 65
Figure 78: Event Capture Encounters Report Sorted by Provider .......................................... 65
Figure 79: Event Capture Encounters Report from Export .................................................. 65
Figure 80: Ordering Section Summary Report Required Information .................................... 66
Figure 81: Ordering Section Summary Report from Print Preview ....................................... 67
Figure 82: Ordering Section Summary Report from Export ................................................ 67
Figure 83: Patient Summary Report Required Information without Reasons ....................... 68
Figure 84: Patient Summary Report from Report Preview without Reasons ........................ 69
Figure 85: Patient Summary Report from Export without Reasons ...................................... 69
Figure 86: Patient Summary Report Required Information with Reasons ......................... 70
Figure 87: Patient Summary Report from Report Preview with Reasons ............................. 70
Figure 88: Patient Summary Report from Export with Reasons ......................................... 71
Figure 89: PCE Data Summary Report Required Information .............................................. 72
Figure 90: PCE Data Summary Report from Print Preview ................................................ 72
Figure 91: PCE Data Summary Report from Export ............................................................ 73
Figure 92: Procedure Reasons Report Required Information .............................................. 74
Figure 93: Procedure Reasons Report from Print Reviews ................................................ 74
Figure 94: Procedure Reasons Report from Export ............................................................. 75
Figure 95: Provider Summary Report Required Information ................................................. 75
Figure 96: Provider Summary Report from Print Preview .................................................... 76
Figure 97: Provider Summary Report from Export ............................................................... 76
Figure 98: Provider (1-7) Summary Report Required Information ....................................... 77
Figure 99: Summary Report from Print Preview .................................................................... 77
Figure 100: Provider (1-7) Summary Report from Export ................................................... 78
Figure 101: Report Selection Screen for ECMGR Key Holders ........................................... 79
Figure 102: Category Report Required Fields ....................................................................... 80
Figure 103: Category Report (Active) from Print Preview ................................................................. 80
Figure 104: Category Report (Active) from Export ........................................................................... 81
Figure 105: Category Report (Inactive) from Print Preview ............................................................... 81
Figure 106: Category Report (Inactive) from Export ........................................................................ 81
Figure 107: Category Report (Both Active and Inactive) from Print Preview .................................... 82
Figure 108: Category Report (Both Active and Inactive) from Export .............................................. 82
Figure 109: Disabled Category and Procedure Summary Required Fields ........................................ 83
Figure 110: Disabled Category and Procedure Summary ................................................................. 84
Figure 111: Disabled Category and Procedure Summary from Export .......................................... 84
Figure 112: DSS Units with Any Associated Stop Code Errors Required Fields ............................... 85
Figure 113: DSS Units with Any Associated Stop Code Errors ....................................................... 86
Figure 114: DSS Units with Any Associated Stop Code Errors from Export ................................. 86
Figure 115: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report .................. 87
Figure 116: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from Print Preview ................................................................. 87
Figure 117: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from Export 88
Figure 118: DSS Unit User Access Report Required Fields ............................................................ 88
Figure 119: DSS Unit User Access Report from Print Preview ......................................................... 89
Figure 120: DSS Unit User Access Report from Export ................................................................. 89
Figure 121: Event Code Screens with CPT Codes Report Required Fields ...................................... 90
Figure 122: Event Code Screens with CPT Codes Report from Print Preview (Both Active and Inactive CPT Codes Selected) ................................................................................. 90
Figure 123: Event Code Screens with CPT Codes Report from Export ......................................... 91
Figure 124: Event Code Screens with Inactive Default Associated Clinic ....................................... 91
Figure 125: Event Code Screens with Inactive Default Associated Clinic from Print Preview ....... 92
Figure 126: Event Code Screens with Inactive Default Associated Clinic from Export ............... 92
Figure 127: Inactive Person Class Report Required Information ...................................................... 93
Figure 128: Inactive Person Class Report from Print Preview ........................................................ 94
Figure 129: Inactive Person Class Report from Export ........................................................................ 94
Figure 130: National/Local Procedure Codes with Inactive CPT Codes Requirements .................. 95
Figure 131: National/Local Procedure Codes with Inactive CPT Codes Report Print Preview ...... 95
Figure 132: National/Local Procedure Codes with Inactive CPT Codes Report from Export ...... 95
Figure 133: National/Local Procedure Report (Active) Requirements ............................................. 96
Figure 134: National/Local Procedure Report (Active) from Print Preview ..................................... 97
Figure 135: National/Local Procedure Report (Active) from Export ........................................... 97
Figure 136: National/Local Procedure Report (Inactive) Required Fields .................................. 98
Figure 137: National/Local Procedure Report (Inactive) from Print Preview .................................. 98
Figure 138: National/Local Procedure Report (Inactive) from Export .......................................... 99
Figure 139: Print Category and Procedure Summary (Report) Required Fields ............................. 100
Figure 140: Print Category and Procedure Summary (Report) from Print Preview .......................... 101
Figure 141: Print Category and Procedure Summary (Report) from Export .................................... 101
Figure 142: Send No Records DSS Units Report Required Fields .............................................. 102
Figure 143: Send No Records DSS Units Report from Print Preview ........................................... 102
Figure 144: Send No Records DSS Units Report from Export ..................................................... 103
Figure 145: Event Capture Management Main Menu ................................................................. 103
Figure 146: Management Menu (Locations) Screen ................................................................. 104
Figure 147: Edit Location Screen ............................................................................................... 104
Figure 148: Sort Menu Options .................................................................................................. 105
Figure 149: Creating a Current Location ..................................................................................... 105
Figure 150: Removing a Current Location .................................................................................... 105
Figure 151: ECS Location Table Export from Excel ................................................................. 106
Figure 152: DSS Units Screen on Management Menu ............................................................... 107
Figure 153: Report Exported into Excel ...................................................................................... 108
Figure 154: Edit a DSS Unit Screen ............................................................................................ 108
Figure 155: Original Active/Inactive Status ............................................................................... 110
Figure 156: Change from Active to Inactive or Inactive to Active ............................................... 110
Figure 157: Grant Access to DSS Unit Screen ............................................................................ 111
Figure 158: Edit DSS Unit Screen Showing a DSS Unit Set to Allow Categories ......................... 112
Figure 159: Allow Category Use Set to No ................................................................................ 112
Figure 160: Disable Category Warning Pop Up Message ........................................................... 112
Figure 161: Edit DSS Unit Screen After Disabling Categories ................................................... 113
Figure 162: Grant Access to DSS Units by User ........................................................................ 114
Figure 163: Grant Access to DSS Units by User ........................................................................ 114
Figure 164: Categories Main Screen on Management Menu ..................................................... 115
Figure 165: Add Category Screen .............................................................................................. 116
Figure 166: Update Category Screen ........................................................................................ 116
Figure 167: ECS Category Table Export from Excel ................................................................. 116
Figure 168: Procedures Main Screen Management Menu ........................................................... 117
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>169</td>
<td>Add Local Procedure</td>
<td>118</td>
</tr>
<tr>
<td>170</td>
<td>Adding a Local Procedure</td>
<td>118</td>
</tr>
<tr>
<td>171</td>
<td>Update a Local Procedure</td>
<td>119</td>
</tr>
<tr>
<td>172</td>
<td>Editing a Local Procedure</td>
<td>119</td>
</tr>
<tr>
<td>173</td>
<td>Update After Editing a Local Procedure</td>
<td>120</td>
</tr>
<tr>
<td>174</td>
<td>Export of Procedures into Excel</td>
<td>120</td>
</tr>
<tr>
<td>175</td>
<td>Management Menu (Reasons) Screen</td>
<td>121</td>
</tr>
<tr>
<td>176</td>
<td>Reasons Screen with Inactive Reasons Highlighted</td>
<td>121</td>
</tr>
<tr>
<td>177</td>
<td>Reasons Screen with Inactive Reasons Moved to the Active Column</td>
<td>122</td>
</tr>
<tr>
<td>178</td>
<td>Confirmation Prompt</td>
<td>122</td>
</tr>
<tr>
<td>179</td>
<td>Reasons Screen with Active Reasons Highlighted</td>
<td>122</td>
</tr>
<tr>
<td>180</td>
<td>Reasons Screen with Active Reasons Moved to the Inactive Column</td>
<td>122</td>
</tr>
<tr>
<td>181</td>
<td>Confirmation Prompt</td>
<td>123</td>
</tr>
<tr>
<td>182</td>
<td>Event Capture – New Reason Screen</td>
<td>123</td>
</tr>
<tr>
<td>183</td>
<td>Reasons Screen with New Reason Added</td>
<td>123</td>
</tr>
<tr>
<td>184</td>
<td>Event Code Screens Example</td>
<td>124</td>
</tr>
<tr>
<td>185</td>
<td>Select Clinic Status for the Report</td>
<td>125</td>
</tr>
<tr>
<td>186</td>
<td>Exported Event Code Table Report</td>
<td>125</td>
</tr>
<tr>
<td>187</td>
<td>Update Event Code Screen Example</td>
<td>125</td>
</tr>
<tr>
<td>188</td>
<td>Adding an Event Code Screen</td>
<td>126</td>
</tr>
<tr>
<td>189</td>
<td>Invalid Associated Clinic Error</td>
<td>127</td>
</tr>
<tr>
<td>190</td>
<td>Update an Event Code Screen</td>
<td>127</td>
</tr>
<tr>
<td>191</td>
<td>Event Code Screen with Active DSS Unit Selected</td>
<td>128</td>
</tr>
<tr>
<td>192</td>
<td>Copy EC Screens to Another DSS Unit on Edit Menu</td>
<td>128</td>
</tr>
<tr>
<td>193</td>
<td>Select a Target Screen</td>
<td>128</td>
</tr>
<tr>
<td>194</td>
<td>Copy Event Code Screen</td>
<td>129</td>
</tr>
<tr>
<td>195</td>
<td>Record Not Filed Error Message for Key Data Missing</td>
<td>129</td>
</tr>
<tr>
<td>196</td>
<td>Inactivate Selected Event Code (EC) Screens for Given Procedure Code</td>
<td>130</td>
</tr>
<tr>
<td>197</td>
<td>Entries Selected to be Inactivated</td>
<td>131</td>
</tr>
<tr>
<td>198</td>
<td>Confirmation Message Dialog for Inactivate Event Code Screens</td>
<td>131</td>
</tr>
<tr>
<td>199</td>
<td>Event Code Screens That Were Inactivated</td>
<td>132</td>
</tr>
<tr>
<td>200</td>
<td>Verifying that EC Screens were Inactivated</td>
<td>132</td>
</tr>
<tr>
<td>201</td>
<td>Desktop Menu Displayed After Right Click</td>
<td>133</td>
</tr>
<tr>
<td>202</td>
<td>Screen Resolution Display</td>
<td>134</td>
</tr>
</tbody>
</table>
Figure 203: Menu Displayed After Selecting Screen Resolution Button (NVIDIA Graphics Card Menu) 134
1 Introduction

The Event Capture Graphical User Interface (GUI) User Manual provides instructions for using the Event Capture options within the GUI setting. The target audience for this manual includes Event Capture managers, application coordinators (ADPACs) and other software users.

The GUI provides a consistent, event-driven, Windows® style user interface for Event Capture.

The Event Capture software provides a mechanism to track and account for procedures and delivered services that other Veterans Health Information Systems and Technology Architecture (VistA) packages do not handle. The procedures and services tracked through Event Capture are associated with the following:

- The patient to whom they were delivered
- The provider requesting the service or procedure
- The DSS Unit responsible for delivering the service

DSS Units typically represent the smallest identifiable work unit in a clinical service at a medical center. Veterans Affairs Medical Centers (VAMCs) define the DSS Units. A DSS Unit can represent any of the following:

- An entire service
- A section of a service
- A small section within a section
- A medical equipment item used in patient procedures

The user must define the following items for every DSS Unit:

- **Service**: The service associated with the DSS Unit
- **Cost Center**: The fiscal identifier for the service using the particular DSS Unit (Cost Centers are defined in detail in the MP4-Part V Appendix B of the Fiscal Service Cost Manuals)
- **Medical Specialty**: The specialty section associated with the DSS Unit

1.1 Purpose

The Event Capture GUI User Manual is intended for use as an instructional guide to using the Event Capture software. The user can use this manual in conjunction with the Event Capture GUI online help option.

Screen displays may vary among different sites, and the data may not appear on the terminal exactly as shown in this manual. Although screens are subject to modification, the major menu options as they appear in this manual are fixed and are not subject to modification (except by the package developer).

1.2 Document Orientation

1.2.1 Organization of the Manual

1.2.2 Assumptions

This guide was written with the following assumed experience/skills of the audience:

- User has basic knowledge of the operating system (such as the use of commands, menu options, and navigation tools).
• User has been provided the appropriate active roles, menus, and security keys required for the Event Capture System (ECS).
• User is using ECS to do their job.
• User has validated access to ECS.
• User has completed any prerequisite training.

1.2.3 Disclaimers
The following disclaimers apply to all Department of Veterans Affairs (VA) user documentation.

1.2.3.1 Software Disclaimer
This software was developed at the VA by employees of the Federal Government in the course of their official duties. Pursuant to title 17 Section 105 of the United States Code, this software is not subject to copyright protection and is in the public domain. VA assumes no responsibility whatsoever for its use by other parties, and makes no guarantees, expressed or implied, about its quality, reliability, or any other characteristic. We would appreciate acknowledgement if the software is used. This software can be redistributed and/or modified freely provided that any derivative works bear some notice that they are derived from it, and any modified versions bear some notice that they have been modified.

1.2.3.2 Documentation Disclaimer
The appearance of external hyperlink references in this manual does not constitute endorsement by the VA of this website or the information, products, or services contained therein. The VA does not exercise any editorial control over the information you may find at these locations. Such links are provided and are consistent with the stated purpose of the VA.

1.2.4 Documentation Conventions
To avoid displaying sensitive information regarding our patients and staff, the examples in this manual contain pseudonyms or scrambled data instead of real names. Our patients and staff will be referred to as “ECPATIENT, ONE”, “AAECPROVIDER, ONE”, or “USER, ONE.” Scrambled data are a series of random letters that replace a real name like “AAADY, JWHTRE”. Likewise, real social security numbers (SSNs), real addresses, and other personal identifiers are not used.

1.2.5 References and Resources
The documentation for Event Capture v2.0 includes the following related manuals:

• Event Capture Installation Guide
• Event Capture Patch Description
• Event Capture Technical Manual
• Event Capture GUI Release Notes

These documents can be found at on the VA Documentation Library (VDL) site.

Patch information and documentation is also available online at the MCA Learning Community for Event Capture site.
1.3 National Service Desk and Organizational Contacts

The three tiers of support documented herein are intended to restore normal service operation as quickly as possible and minimize the adverse impact on business operations, ensuring that the best possible levels of service quality and availability are maintained.

Table 1 lists organizational contacts needed by site users for troubleshooting purposes. Support contacts are listed by name of service responsible to fix the problem, description of the incident escalation, associated tier level, and contact information (email and phone number).

<table>
<thead>
<tr>
<th>Name</th>
<th>Role</th>
<th>Org</th>
<th>Contact Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ECS Package Manager</td>
<td>Tier 0 Support</td>
<td>VHA</td>
<td>ECS Package Manager/Site Dependent</td>
</tr>
<tr>
<td>Local MCA VISN Coordinator</td>
<td>Tier 0 Support</td>
<td>VHA</td>
<td>Site Dependent</td>
</tr>
<tr>
<td>OI&amp;T National Service Desk</td>
<td>Tier 1 Support</td>
<td>OI&amp;T</td>
<td><a href="mailto:Nationalservicedeskanr@va.gov">Nationalservicedeskanr@va.gov</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1-855-673-4357</td>
</tr>
<tr>
<td>Health Product Support</td>
<td>Tier 2 Support</td>
<td>VHA</td>
<td><a href="mailto:Nationalservicedeskanr@va.gov">Nationalservicedeskanr@va.gov</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1-855-673-4357</td>
</tr>
<tr>
<td>VistA Maintenance Management</td>
<td>Tier 3 Application</td>
<td>OI&amp;T</td>
<td><a href="mailto:OITPDVistAMaintenanceManagementSystems@va.gov">OITPDVistAMaintenanceManagementSystems@va.gov</a></td>
</tr>
<tr>
<td>Systems</td>
<td>Support</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2 System Summary

ECS is a VistA Class I workload reporting system supporting operations of the VA Managerial Cost Accounting Office (MCAO). There are several Veterans Health Administration (VHA) national programs mandating utilization of ECS in place of or to augment other workload capture information systems. For example, ECS is leveraged when programs cannot report workload in the form of Current Procedural Terminology (CPT) codes. Other times, ECS allows for more precise workload capture and reporting than otherwise possible through another VistA system.

Event Capture with all patches installed provides the following functions:

- Allows each VAMC to utilize the software for its own resource/costing needs
- Implements DSS Units
- Assigns user access
- Allows single and batch data entry for patient procedures
- Generates reports for workload and other statistical tracking
- Provides a graphical user interface to the ECS application
- Allows user to upload patient encounter data to Event Capture from a spreadsheet
- Allows user to switch between Computerized Patient Record System (CPRS) and ECS without having to log back into the EC GUI.exe

2.1 System Configuration

Please refer to the Event Capture Technical Manual for details related to system and site configuration.

2.2 Data Flows

Figure 1 demonstrates the ECS data flow.

![ECS Data Flow Diagram](image)

2.3 User Access Levels

Security keys are assigned in VistA using the option Key Management main menu and then choosing the submenu Allocation of Security Keys.

ECS provides the following security key options for user access:
- ECMGR: Gives a user access to the ECS Management Menu – only for Event Capture managers
- ECALLU: Gives a user access to all DSS Units (super user). This key should be assigned only to those managing the software (i.e., holders of the ECMGR key)
- ECNORPT: Restricts the user from accessing Event Capture reports
- ECSPSH: Gives a user access to upload data from a spreadsheet (required for State Home Spreadsheet upload)

2.4  **Continuity of Operations**
Each site has a backup emergency plan in place in the event that the system goes down.

2.5  **Section 508 Compliance**
Section 508 of the Rehabilitation Act Amendments of 1998 requires that when Federal agencies develop, procure, maintain, or use electronic and information technology, they shall ensure that the electronic and information technology enables persons with disabilities to have access to, and use of, information and data that is comparable to the access to and use of information and data by persons who are not individuals with disabilities, unless an undue burden would be imposed on the agency.

The Section 508 Accessibility Testing and Training Center (T&TC) was consulted and modifications to the GUI have been made to meet the requirements for Section 508 compliance. Event Capture was modified to enable screen readers to accurately interpret information on the screens. As a result, some buttons and boxes have been moved, replaced or renamed, and some screen titles have been modified.

For more information on the VA Section 508 compliance efforts, please visit the [Section 508 website](#).
3 Getting Started

Event Capture must be set up by using the options in the Event Capture Management Menu before any data can be entered. Access to this menu should be restricted to the ADPAC and his or her designees. The Event Capture ADPAC should use the following steps as a guide for setting up the Event Capture software.

Step 1. Select security keys.

- See Section 2.3 of this document for a description of ECS security keys.

Step 2. Select required VistA settings.

- Users must be assigned the EC GUI CONTEXT VistA menu options in order for the ECS GUI to work.

Step 3. Create an Event Capture Location.

- Create a location using the Location - Update Location Information option.
  
  Notes:
  - The selected location must be in the INSTITUTION file (#4).
  - At least one location must exist before DSS Units can be established.

Step 4. Establish DSS Units for each service.

- Contact each service for a list of its DSS Units, the names of its Event Capture users and the DSS Units for which they will enter data, and for individual product resource tracking needs.
- Use the DSS Unit - Add or Update DSS Units option to establish DSS Units for each service.

  Note:
  - At least one DSS Unit must exist before Event Code Screens can be created.

Step 5. Assign user access to specific DSS Units.

- Use the Access by User - Grant Access to DSS Units by User option to assign user access to specific DSS Units for the users identified in Step 4.
- Assign the ECALLU security key only to those users who should have access to all DSS Units.

  Notes:
  - Users must have access to DSS Units before they can begin entering data.
  - Use the Access by User – Grant Access to DSS Units by User option to remove user access for a specific DSS Unit. Users with the ECALLU security key cannot be denied access to DSS Units.

Step 6. Create Categories.

- Use the Category - Add or Update Categories option to create categories before the user sets up Event Code Screens.

  Notes:
  - Creating categories is optional.
  - After completion of this step, the Category Report option on the Reports Menu can be used to print a report of the site’s categories.

Step 7. Create or edit local procedures in the EC NATIONAL PROCEDURE file (#725).
• Use the Procedure - Add or Update Local Procedures option to enter new, or edit existing, local procedures in the EC NATIONAL PROCEDURE file (#725).
• Adding local procedures is optional and not encouraged.

Notes:
• Before starting this step, use the National/Local Procedure Report option on the Reports Menu to print a list of procedures with their associated CPT codes. This report can be quite lengthy if it includes national procedures, so it should be queued to print to a device during non-peak hours.
• An associated CPT code must be entered to pass local procedures to PCE.
• Use this option to edit, but not delete, existing local procedures and to select an associated CPT code if this workload data should be sent to PCE.

Step 8. Use the Event Code Screen - Add or Update Event Code Screens option to:

• Create an Event Code Screen for each procedure tracked in the Event Capture software.
• Enter or edit an optional active associated clinic for DSS Units that are marked to send data to PCE. If an Associated Clinic has non-conforming stop codes, the clinic will not be selectable.
• Enter or edit an optional procedure Synonym.
• Set Ask Reasons? radio button to Yes or No.
• Enter or edit procedure default Volume.

Note:
• An Event Code Screen for the procedure must be created before it can be used for data entry.

Step 9. Optional: Print the Event Code Screens Sorted by DSS Units

• Use the Print Category and Procedure Summary (Report) option on the Reports Menu to print the Event Code Screens sorted by DSS Units.

Notes:
• Data entry clerks might find the output generated by this report useful as a procedure reference guide.

Step 10. Event Capture set up is complete.

• Services can now enter data using the Data Entry options and provide summary reports using the Reports options.

3.1 Logging On
Event Capture is accessed through a desktop shortcut that points to the location of the EC GUI application. If the shortcut does not appear, refer to the Installation Guide for Event Capture, or ask the local support staff for assistance.

Figure 2: ECS GUI Icon

Double clicking the EC GUI shortcut will launch the application, and the VistA Sign-on screen will be displayed. Enter valid Access and Verify codes, then click the OK button.
3.2 Event Capture Main Menu

The Event Capture software contains four menus. The user must hold the ECSPSH security key to have access to the Spreadsheet option, and the ECMGR security key to have access to the Management Menu functions. Users without the ECMGR security key will have fewer reports available for selection than users with the ECMGR security key. Users with the ECNORPT security key will not have access to the Reports option.

The following Main Menu options display when the Event Capture GUI opens.
3.2.1 Icon Shortcuts

The icon shortcuts can be used to access options in Event Capture.
3.2.2 Menu Bar
The Event Capture menu bar enables the user to access shortcut commands.

- The File menu item enables the user to Exit the application.
- The Function menu item on the main window provides access to Data Entry, Spreadsheet (if the user has the proper security key), Reports and Management Menu functions.
- The View menu item enables the user to show or hide the Toolbar and Status Bar.
- The Help menu item provides topic-specific help, or information about the Event Capture system.

3.3 Menu Bar for Specific Functions
The menu bar functions are described in the subsections below.

3.3.1 Data Entry Menu Bar
The Data Entry menu bar consists of the File, Edit, View, and Help menus.
Figure 9: Data Entry Menu Options

- The File menu item provides the option for the user to Exit the window.
- The Edit menu item provides access to Data Entry by Patient, Data Entry by Procedure and Multiple/Multiple functions.
- The View menu item enables the user to show or hide the Toolbar and Status Bar.
- The Help menu item provides topic-specific help, or information about the Event Capture system.

Figure 10: Data Entry with Menus Expanded

3.3.2 Spreadsheet Menu Bar
The Spreadsheet menu bar consists of the File, Edit, EC Upload, Spreadsheet Options (if the user has the proper security key), and Help menus.

Figure 11: Spreadsheet Upload Options

- The File menu item enables the user to Exit the window as well as Open Spreadsheet, Open State Home Spreadsheet, Close, Save, Save As and Print a file.
- The Edit menu item provides access to Cut, Copy, Paste, Insert Row and Delete Row functions.
- The EC Upload menu item enables the user to Upload Records to VistA.
- The Spreadsheet Options menu item enables the user to Change Column Headers or Change Duplicate Threshold.
- The Help menu item provides topic-specific help, or information about the Event Capture system.
3.3.3 Reports Menu Bar
The Reports menu bar consists of the File, View, and Help menus.

- The File menu item enables the user to Exit the window.
- The View menu item enables the user to show or hide the Toolbar and Status Bar.
- The Help menu item provides topic-specific help, or information about the Event Capture system.

3.3.4 Management Menu Bars
The Management Menu bar consists of the File, Table, View, and Help menus.

- The File menu item enables the user to Exit the window.
- The Table menu item provides access to Location, DSS Unit, Access by User, Category, Procedure, Reason, Event Code Screen and Inactivate EC Screen functions.
- The View menu item enables the user to show or hide the Toolbar and Status Bar.
- The Help menu item provides topic-specific help, or information about the Event Capture system.
3.4 Changing User ID and Password
To access ECS, users need a VistA Access Code and Verify Code. To change this, please contact the local Information Resource Manager (IRM).

3.5 Exit System
From the main Event Capture menu, click the Exit button to exit the Event Capture GUI. Alternatively, from the same screen, users can go to File > Exit, or click the Close window button in the top right corner of the screen.

3.6 Caveats and Exceptions
On all ECS GUI screens, the previous Location entry will be saved and used as the default on subsequent Location fields.

3.7 Online Documentation
Throughout the entire ECS GUI, click the question mark button located on the toolbar or at the bottom right corner of the screen to obtain online information for any screen. The information provided in the help menus corresponds to the information that is in this user manual.
To obtain online information for a field, click on that field and then press the <F1> key.
3.8 **Event Capture Interface with CPRS**

The ECS GUI is accessible via CPRS. This design is intended to increase the use of Event Capture by clinicians currently using CPRS. The creation of a link and a single point of entry allow users to access both systems.

The interface between CPRS and Event Capture enables users to:

- Access Event Capture from within CPRS through a single sign-on.
- Select Event Capture Interface in the CPRS Tool Menu allowing the user to enter Event Capture patient procedures. This requires set up by local IRM and/or the Clinical Application Coordinator.

3.9 **Timeout Feature**

Event Capture includes a timeout feature consistent with CPRS. A countdown screen will display a warning of the pending timeout of the application when the Event Capture application is idle for a user-defined amount of time. If the user takes no action, the application will close. Click on the Do not close Event Capture button to stay connected.
The amount of time for the timeout and countdown features is user-defined at the application server level.

3.10 CCOW Single Sign On

Event Capture includes Clinical Context Object Workgroup (CCOW) Single Sign-on capability. If a user is signed onto another CCOW Single Sign-on enabled system, launching Event Capture will not require the user to re-enter system Access and Verify codes. The status of the CCOW single sign-on is shown via an icon on a panel in the upper right hand corner of the Main Menu. The hover help will display “Clinical Link On” if Event Capture was accessed via CCOW single sign-on, or “Clinical Link Off” if it was not. The icon on the panel is updated as well.

Figure 19: Event Capture CCOW Status
4 Using the Software

4.1 Data Entry Menu

The Data Entry menu offers the following options:

- Data Entry by Patient – Enter/Edit Patient Procedures
- Data Entry by Procedure – Batch (Same Procedure, Multiple Patients)
- Multiple Dates/Procs – Multiple Dates / Multiple Procedures

![Data Entry Menu Screen]

Figure 20: Data Entry Menu Screen

4.1.1 Data Entry by Patient

Use the Data Entry by Patient option to:

- Enter a single procedure for one patient
- Edit an existing patient procedure
- Delete an existing patient procedure

**Note:**
- Event Code Screens must be defined before entering any Event Capture data.

Users will be presented with:

- A summary screen to identify the Location, DSS Unit, Procedure Date Range, Patient Identifier and any existing procedures for that patient
- A detail screen to show the detailed information about a selected patient procedure
To use the Enter/Edit Patient Procedures screen:

**Step 1. Select a Location.**

- If there is only one Location set up in ECS, the Location on the screen will default to that value.
- If there is more than one Location set up in ECS, the Location on the screen will default to the last Location used. To change the Location, choose a Location from the dropdown list.

**Step 2. Select a DSS Unit.**

- If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or if only one DSS Unit is assigned to the user, that DSS Unit value will default.
- If only one DSS Unit is assigned to the user, it will be the default selection. If more than one DSS Unit is assigned to the user, choose a DSS Unit from the dropdown list of accessible DSS Units.
- The user can add, edit or delete any patient procedure for the selected DSS Unit.
- To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add or Update DSS Units function to add the unit to the dropdown list. The ECMGR key is required.

**Step 3. Select a Date Range.**

- The Procedure Date Range (from/through) will default to the system date. These fields may be edited by typing in a date (dd MMM yyyy) or by using the calendar dropdown.

**Note:**

- An edit check will prevent selecting a date in the future, or displaying a Procedures From date later than the Procedures Through date.
Figure 22: Calendar Dropdown for Date Range View

Step 4. Use the Patient Identifier field to select a patient.

- Enter one of the following:
  - Patient Name (whole or partial, last name first)
  - Social Security Number
  - Last four digits of the Patient Social Security Number
  - First character of Last Name plus the last four digits of the SSN with no spaces
- Click <Enter> or the Search button.
- Choose from the list of patients displayed.

Step 5. View the Patient Procedures.

- Once the previous steps are complete, the bottom section of the window will display the patient procedures in chronological order for the selected search criteria. Each record will display the Category, Procedure, Date/Time, Volume, Associated Clinic, Ordering Section, Primary Diagnosis and Primary Provider.

Notes:

- Click on the field header to sort the data in a different order.
- The Close, Add and Topic Help buttons are always enabled. If patient procedures exist, the Update and Delete buttons will be enabled, as well.
- Clicking on a row will highlight the patient procedure, effectively selecting that row as a candidate for updating or deleting.
Figure 23: Procedure History for Sample Patient

Step 6. Complete data entry.

- Click the Add button to enter a new patient procedure.

Step 7. Click the Update button to display the patient procedure on the Edit Patient Procedure (Detail) screen.

Step 8. Click the Delete button to delete the patient procedure from the file.

4.1.1.1 Recent Visits Screen

To see the Recent Visits screen:

Step 1. On the Enter/Edit Patient Procedures screen, click the Add button to enter a new patient procedure.

Notes:

- The Add button will only display if the selected DSS Unit is set to send to PCE.
- If recent visits exist, the Recent Visits screen will be displayed after clicking the Add button.
Step 2. Selection options on the Recent Visits screen.

- On the Recent Visits screen, the user can choose one of three options: OK, Ignore or Cancel.
  - OK: Select the appropriate Appointment/Encounter from the Recent Visits. Click the OK button to close the screen. The Add Patient Procedure screen will display with the Procedure Date/Time and Associated Clinic fields populated and not modifiable, based on the Appointment/Encounter selected on the Recent Visits screen. Enter the procedure(s), answer classification questions as they pertain to that visit, and enter diagnoses, provider, and other pertinent fields if required (reasons, ordering section and/or modifiers).
  - Ignore: Click the Ignore button on the Recent Visits screen to go to the Add Patient Procedure screen to enter information for all fields.
  - Cancel: Click the Cancel button to close the Recent Visits screen and return to the Enter/Edit Patient Procedures screen.

Note:

- If the Associated Clinic for the selected record is no longer active, clicking the OK button will result in the display of the Error: Invalid Associated Clinic message dialog. The message dialog lists only active Associated Clinics. To update the record, select an active clinic from the list and then click the OK button. Click the Cancel button to open the record and the Associated Clinic field will be blank.
Figure 25: Error: Invalid Associated Clinic Message Dialog

Figure 26: Add Patient Procedure Detail Screen
4.1.1.2  Add Information to the Add Patient Procedure or Edit Patient Procedure Screen

To complete the Add Patient Procedure or Edit Patient Procedure screen:

**Step 1. Select a Category**

- If the Allow Category Use field in the Add DSS Unit Management set up is set to NO, then the Category field will be blank and disabled.
- If only one Category is defined for the specified DSS Unit, that Category will be the default value.

**Step 2. Select the Procedure Date and Time.**

- This information is present if a recent visit was selected on the Recent Visits screen.
- Typing “N” and then clicking <Enter> in the field (instead of clicking the button) will bypass the dialog box, or clicking the Now button in the dialog box will enter the current system date and time. When the Midnight button is clicked, “23:59” is displayed for the time on the date selected.

*Figure 27: Select Date/Time Dialog Box*

**Step 3. Select an Eligibility Code for this procedure.**

- If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure.
- The primary Eligibility Code displays as the default.

**Step 4. Select a Procedure Name.**

- Select a Procedure from the dropdown list.

**Step 5. Enter the Volume for the procedure.**

**Step 6. If applicable, the CPT Modifiers section will be enabled.**

- Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will show.
- Choose a modifier from the Modifiers Available list and click Include.
- Repeat as needed.
- To remove a modifier, choose it from the Modifiers Selected list and click Exclude.
• Press <CTRL-Click> to select multiple modifiers at one time.

**Step 7. If applicable, the Reasons field will be enabled.**

• The user can enter up to three reasons.
• Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
• Reasons appear alphabetically in the dropdown.
• Once selected, a reason will not appear in the dropdown list for remaining reason fields.
• A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason, or enter different letter(s).

**Step 8. If applicable, the mandatory classification questions section will be enabled.**

• Select YES only if the treatment received relates to that classification.
• Press the <F1> key while in the Service Connected field to display a message dialog containing the patient’s service connection and any rated disabilities.

**Figure 28: Service Connection and Rated Disabilities Screen**

Step 9. Select the Ordering Section.

Step 10. Select the Associated Clinic (if not already populated from the Recent Visits screen).

Step 11. Select the associated diagnosis code for the procedure.

• Use the Primary field to enter one of the following:
  – ICD code (whole or partial)
  – Diagnosis Name (whole or partial)
• Click the Search button.
• Select from the resulting dropdown list.
• Repeat as needed to select the secondary diagnosis codes.

Step 12. Select the providers of the services. Use the Providers Available text box to enter the following:

• Provider name (full or partial, last name first)
• Select the provider from the resulting dropdown list and click Include.
• To remove a provider, select from the Providers Selected list and click Exclude.

Step 13. Click the Add button to save the edited procedure and remain on the screen.
Step 14. Click the OK button to save the edited procedure and return to the Enter Patient Procedure screen.
Step 15. Click the Cancel button to return to the Enter Patient Procedure screen without saving the above entries.

Notes:
• If the record transmits to PCE based on the DSS Unit on Management Menu set up, then all fields will be required.
• If the record does not transmit to PCE based on the DSS Unit on Management Menu set up, then the Associated Clinic and the four Secondary Diagnosis fields will be disabled.
• Press the <F1> key while in any field to open a dialog box displaying a help message.

4.1.1.3 Add a Patient Procedure

The following instructions and example assume that a user is entering a patient procedure for a specified patient and that the specified DSS Unit data transmits to PCE.

Step 1. On the main Event Capture menu, select Data Entry.
Step 2. On the Data Entry Menu, select Data Entry by Patient.
• The Enter/Edit Patient Procedures screen appears.

Step 3. Select the Location and DSS Unit.
Step 4. Allow the Procedure Date Range to default to today.
Step 5. Select a Patient.
Figure 29: Enter/Edit Patient Procedures Screen

Step 6. Click Add.

Step 7. If the DSS Unit is set to send to PCE, the Recent Visits screen will appear. Select a scheduled appointment and click OK.

Figure 30: Recent Visits Screen
Step 8. Complete the procedure-related fields on the Add Patient Procedure detail screen according to the field-by-field instructions given in Section 4.1.1.2.

Figure 31: Add Patient Procedure Screen

![Add Patient Procedure Screen](image)

Step 9. Click Add to save the record and clear the fields to add another procedure for this patient.

Step 10. Click the OK button to save the record and return to the Enter/Edit Patient Procedures screen.

Step 11. The Enter/Edit Patient Procedures screen will display any existing procedures for this patient.
Figure 32: Enter/Edit Patient Procedures with New Procedure Added

Step 12. Click Close to return to the Data Entry menu.

4.1.1.4 Edit a Patient Procedure

Step 1. On the main Event Capture menu, select Data Entry.
Step 2. On the Data Entry Menu, select Data Entry by Patient.
Step 3. The Enter/Edit Patient Procedures screen appears.
Figure 33: Enter/Edit Patient Procedures Screen

Step 4. Select the Location and DSS Unit.

Step 5. Enter a Procedure Date Range by using the calendar dropdowns. The default is today.


Step 7. The lower portion of the screen will display the procedure(s) for the selected patient and the DSS Unit within the date range.

Step 8. Choose a procedure and click Update.

Step 10. Complete the procedure-related fields on the Edit Patient Procedure detail screen according to the field-by-field instructions given in section 4.1.1.

Step 11. Click Add to save the detail entries and open another detail screen for this patient.

Step 12. Click the OK button to save the detail entries and return to the Enter/Edit Patient Procedures screen.

Step 13. The Enter/Edit Patient Procedures screen will display the procedure(s) (Figure 32) entered for this patient.

Step 14. Click Close to return to the Data Entry menu.

4.1.1.5 Delete a Patient Procedure

Step 1. On the main menu, select Data Entry.

Step 2. On the Data Entry Menu, select Data Entry by Patient.

Step 3. The Enter/Edit Patient Procedures summary screen appears.
Step 4. Select the Location and DSS Unit.

Step 5. Enter a procedure date range by using the calendar dropdowns. The default is today.


Step 7. The lower portion of the screen will display the procedure(s) for the selected patient and the DSS Unit within the date range.

Step 8. Choose a procedure and click Delete.

Step 9. A confirmation message appears.

- Click the Yes button on the confirmation message dialog, and an Information message dialog appears to show the selected procedure was deleted for the patient. Click the OK button to return to the Enter/Edit Patient Procedures screen.
- Click the No button on the confirmation message dialog to return to the Enter/Edit Patient Procedures screen without deleting the procedure.

Figure 36: Procedure Deleted Confirmation Dialog
Step 10. The screen will now refresh to show the remaining procedures entered for this patient.

**Figure 37: Confirmation Message**

![Image of a confirmation message]

**Figure 38: Enter/Edit Patient Procedures Screen with Procedure Deleted**

![Image of the enter/edit patient procedures screen]

Step 11. Click Close to return to the Data Entry menu.

### 4.1.2 Data Entry by Procedure

Use the **Data Entry by Procedure** option to:

- Enter/edit the same procedure for multiple patients

**Note:**

- Event Code screens must be defined before entering any Event Capture data.

Users will be presented with:
The left side of the screen contains information for the procedure that the system will use for all patients. (Note: The user will enter the procedure information only one time.)

The right side of the screen identifies each patient. The user will complete this section for each patient. Click Add to file the data, and clear the fields to enter data for the next patient.

The View button displays a listing of all patients entered for this procedure in this session.

Figure 39: Same Procedure, Multiple Patients Screen

4.1.2.1 Add a Procedure for Multiple Patients

The following instructions and example assume that the user wants the specified DSS Unit to send data to PCE.

Step 1. Select a Location.

- If there is only one Location set up for the Event Capture System, the Location on the screen will default to that value.
- If there is more than one Event Capture Location set up, the Location will default to the last Location used. To change the Location, choose a Location from the dropdown list of available Event Capture Locations.

Step 2. Select a DSS Unit.

- If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the user, that DSS Unit will be the default value.
• If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit from a dropdown list of accessible DSS Units.
• The user can add, edit or delete any patient procedure for the selected DSS Unit.
• To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add or Update DSS Units function to add the unit to the dropdown list.

Step 3. Select a Category.
• If only one category is defined for the specified DSS Unit, that category will be the default.

Step 4. Select the Procedure Date and Time.
• Typing “N” and then clicking <Enter> in the field (instead of clicking the button) will bypass the date/time dialog, or clicking the Now button on the date/time dialog will enter the current system date and time. When the Midnight button is clicked, “23:59” is displayed for the time on the date selected.

Figure 40: Select Date/Time Dialog

Step 5. Select a Procedure Name.
• Select a procedure from the dropdown list.

Step 6. If applicable, the Reasons field will be enabled.
• The user can enter up to three reasons.
• Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
• Reasons appear alphabetically in the dropdown.
• A reason will not appear in the dropdown list for remaining reason fields as an option once selected.
• A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason or enter different letter(s).

Step 7. If applicable, the CPT Modifiers section will be enabled.
• Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will show.

• Choose a modifier from the Modifiers Available list and click the right pointer icon. Repeat as needed.

• To remove a modifier, choose it from the Modifiers Selected list and click the left pointer icon.

• Press <CTRL-Click> to select multiple modifiers at one time.

**Step 8.** Select the providers of the services. Use the Providers Available text box to enter the following:

• Provider name (full or partial, last name first)

• Select the provider from the resulting dropdown list and click the right pointer icon.

• To remove a provider, select from the Providers Selected list and click the left pointer icon.

**Step 9.** Use the Patient Identifier field to select a patient.

• Enter one of the following:
  – Patient Name (whole or partial, last name first)
  – Social Security Number
  – Last four digits of the Patient Social Security Number
  – First character of Last Name plus the last four digits of the SSN with no spaces

• Click <Enter> or the Search button.

• Choose from the list of patients displayed.

**Step 10.** Select an Eligibility Code for this procedure.

• If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure.

• The primary Eligibility Code displays as the default.

**Step 11.** Enter the Volume for the procedure.

**Step 12.** If applicable, the mandatory classification questions section will be enabled.

• Select YES only if the treatment received relates to that classification.

• Pressing the <F1> key while in the Service-Connected field will open a message dialog displaying the patient’s service connection and any rated disabilities.
Figure 41: Service Connection and Rated Disabilities Dialog

Step 13. Select the Ordering Section.

Step 14. Select an Associated Clinic for the specified DSS Unit, if applicable.

Step 15. Select the associated diagnosis code for the procedure.

- Use the Primary field to enter one of the following:
  - ICD code (whole or partial)
  - Diagnosis Name (whole or partial)

- Click the Search button.
- Select from the resulting dropdown list.
- Repeat as needed to select the Secondary Diagnosis Codes.

Step 16. Click the Add button to add this procedure for the patient. The right side of the screen will reset to enter this procedure for another patient. Select the next patient for this procedure. Repeat the patient related steps above.

Step 17. Click the OK button to add this procedure to the patient’s record and return to the Data Entry menu.

Step 18. Click the View button to verify that the list of patients entered is correct. The following screen will list all of the patients entered for the procedure that was selected.
Step 19. To correct an entry, return to the Data Entry menu and select Data Entry by Patient.

4.1.3 Multiple Dates / Multiple Procedures

Use the Multiple Dates / Multiple Procedures option to:

- Add multiple dates and multiple patients for multiple procedures.

**Notes:**

- Event Code screens must be defined before entering any Event Capture data.
- Use the Data Entry by Patient option to make corrections to erroneous patient data.

Users will be presented with:

- An area at the top of the first screen for entering common fields (Location, DSS Unit and Category) as well as the Procedure Date/Time.
- Three tabs for entering providers, procedures and patients.
- Two tabs for checking work before submitting.
4.1.3.1 Instructions for Common Fields

Step 1. Select a Location.

- If there is only one Location set up for the Event Capture System, the Location on the screen will default to that value.
- If there is more than one Event Capture Location set up, the Location will default to the last Location used. To change the Location, choose a Location from the dropdown list of available Event Capture Locations.

Step 2. Select a DSS Unit.

- If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the user, that DSS Unit will be the default value.
- If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit from a dropdown list of accessible DSS Units.
- The user can add, edit or delete any patient procedure for the selected DSS Unit.
- To gain access to an existing DSS Unit, go the Event Capture Manager must assign it to the user.

Step 3. Select a Category.
- If categories are not allowed in the DSS Unit, the selection box will be disabled.
- If only one category is defined for the specified DSS Unit, that category will be the default.

**Step 4. Select the Procedure Dates and Time by using the Select Date/Time dialog.**

![Select Date/Time Dialog](image)

- Select date and time and click the OK button to close the dialog.
- Click the Add Date/Time button to add the choice to the Selected Dates list.
- Select and add dates as needed.
- To remove a date, choose it from the list and click the Delete Date/Time button.

**Notes:**
- To bypass the Date/Time dialog, type “N” and press <Enter> in the field (instead of clicking the button.)
- To enter the current system date and time, click the Now button on the Date/Time dialog.
- When the Midnight button is clicked, “23:59” is displayed for the time on the date selected.

**Step 5. Click and complete the tabs for Providers, Procedures and Select Patient as described in Sections 4.1.3.2, 4.1.3.3, and 4.1.3.4.**

**Step 6. Use the View Selected Patients and Records Pending Filing tabs to check the work as described in Sections 4.1.3.5 and 4.1.3.6.**

**Step 7. Click the Save button at the bottom of the screen to process the transactions shown on the Records Pending Filing tab, and then redisplay the screen initialized for a new set of entries.**

**Step 8. Click the OK button at the bottom of the screen to process the transactions shown on the Records Pending Filing tab, and then return to the Data Entry menu.**

**4.1.3.2 Add Information to Providers Tab**

**Step 1. Click on the Providers tab to select one or more providers.**
Figure 45: Multiple Dates/Multiple Procedures Screen, Providers Tab

Step 2. Select a Provider.

- Use the Providers Available list to enter the full or partial provider name (last name first)
- Select the provider from the resulting dropdown list and click the Include button.
- To remove a provider, select from the Providers Selected list and click the Exclude button.

Step 3. Repeat as needed to add providers.

4.1.3.3 Add Information to Procedures Tab

Step 1. Click on the Procedures tab to select one or more procedures.
Figure 46: Multiple Dates/Multiple Procedures Screen, Procedures Tab

Step 2. Select a Procedure Name.
- Select a procedure from dropdown list.

Step 3. Enter the Volume for this procedure.

Step 4. If applicable, the Reasons field will be enabled.
- The user can enter up to three reasons.
- Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
- Reasons appear alphabetically in the dropdown.
- A reason will not appear in the dropdown list for remaining reason fields as an option once selected.
- A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason or enter different letter(s).

Step 5. If applicable, the Modifiers section will be enabled.
Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will display.

- Choose a Modifier from the Modifiers Available list and click the Include button.
- Repeat as needed.
- To remove a modifier, choose it from the Modifiers Selected list and click the Exclude button.
- Click <CTL-Click> to select multiple modifiers at one time.

**Step 6.** Click the Add Procedure button to add this procedure to the Procedures Selected list and display a blank screen ready for another entry.

**Step 7.** To add another procedure, repeat the steps above.

**Step 8.** To delete a procedure, choose it from the Selected Procedures list and click the Delete Procedure button.

**Step 9.** To view a procedure in an expanded format, choose it from the Selected Procedures list and click the View Details button. The View Procedure Record Details screen is not editable.

**Figure 47: View Procedure Record Details Screen**

To view a procedure in an expanded format, choose it from the Selected Procedures list and click the View Details button. The View Procedure Record Details screen is not editable.

**Step 10.** Click the Close Procedure View button to return to the Procedures tab.

### 4.1.3.4 Add Information to Select Patient Tab

**Step 1.** Click on the Select Patient tab to select one or more patients.
Step 2. Use the Patient Identifier field to select a patient.

- Enter one of the following:
  - Patient Name (whole or partial, last name first)
  - Social Security Number
  - Last four digits of the patient Social Security Number
  - First character of Last Name plus the last four digits of the SSN with no spaces
- Press <Enter> or click the Search button.
- Choose from the list of patients displayed.

Step 3. Select an Eligibility Code for this procedure.

- If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure.
- The primary Eligibility Code displays as the default.

Step 4. If applicable, the mandatory Encounter Related classification questions section will be enabled.

- Select YES only if the treatment received relates to that classification.
• Pressing the <F1> key while in the Service-Connected field will open a message dialog displaying the patient’s service connection and any rated disabilities.

**Figure 49: Service Connection and Rated Disabilities Dialog**

![Service Connection and Rated Disabilities Dialog](image)

---

**Step 5.** Select the Ordering Section.

**Step 6.** Select the Associated Clinic.

**Step 7.** Select the associated diagnosis code for the procedure.

• Use the Primary field to enter one of the following:
  – ICD code (whole or partial)
  – Diagnosis Name (whole or partial)

• Click the Search button.
• Select from the resulting dropdown list.
• Repeat as needed to select the Secondary Diagnoses Codes.

**Step 8.** Click the Add Patient button to add this patient to the list of Selected Patients and display a blank screen ready for another entry.

**Step 9.** Use the View Selected Patients tab to check the work.

### 4.1.3.5 Verify Information Using the View Selected Patients Tab

**Step 1.** Click on the View Selected Patients tab to review the list of selected patients.
Figure 50: Multiple Dates/Multiple Procedures View Selected Patients Tab

Step 2. To remove a patient from the list, select the record and click the Delete Patient button. Click the Yes button on the Confirmation message dialog.

Figure 51: Deleting Patient Confirmation Dialog

Step 3. To view a patient in an expanded format, select the record and click the View Details button. The patient record is not editable using the View Patient Record Detail screen.
Figure 52: View Patient Record Details Screen

Step 4. Click the Close Patient View button to return to the View Selected Patients tab.

4.1.3.6 Verify Information Using the Records Pending Filing Tab

Step 1. Click on the Records Pending Filing tab to view a list of the records to be filed.

Note:

- This screen is not editable.
This screen lists the individual records (transactions) that will be processed when the OK or Save button at the bottom of the screen is clicked. An information dialog will appear on the screen to show the number of records added.

**Note:**
- Click the OK button to return to the Data Entry menu, or click Save to add more entries.

**Figure 54: Information Dialog after Saving**

The records consist of every combination of the dates, procedures, and patients selected on the tabs described in the preceding sections, and the providers selected will be assigned to each record.

**Step 2.** To change the list, review and revise the selections on the Providers, Procedure and Select Patient tabs and for the Selected Dates/Times field.

**Step 3.** To correct an entry, return to the Data Entry menu and select Data Entry by Patient.
4.2 Spreadsheet

Data can be batch processed in the Event Capture GUI using the spreadsheet import and upload options. Two types of spreadsheet can be used for this data entry – the original “regular” spreadsheet, or the new State Home spreadsheet. Both methods of import are launched from the Spreadsheet Upload screen. Once a spreadsheet is imported into Event Capture, the data can be uploaded to VistA.

The user will see a Spreadsheet Upload screen similar to the screenshot below.

![Spreadsheet Upload Screen](image)

4.2.1 Import a Regular Spreadsheet

This is the traditional method for batch processing spreadsheet data that has been available since the inception of the Event Capture GUI. The spreadsheet import functionality works with MS Excel® files, as well as with tab or comma delimited files. All versions of Excel spreadsheets are compatible with this functionality.

**Notes:**
- A template with default column order is available to aid in populating spreadsheets prior to import. The header row will not be processed when data are imported; therefore, it can remain in the spreadsheet during the import process.
- The template is available on the VA [EC Template.xlsx](mailto:EC_Template.xlsx).
- Once the template is downloaded, save it to a local hard drive for later use.

Steps for importing a regular spreadsheet:
Step 1. Click the Open a Regular Spreadsheet button, or select the Open Spreadsheet option from the File menu. A standard Select File dialog will be displayed, allowing the user to select the spreadsheet to be imported.

Note:
- Both *.XLS (pre-2007) and *.XLSX versions of MS Excel spreadsheets are valid for use in the Event Capture spreadsheet import process.

![Select File Dialog - Open a Spreadsheet](image)

Figure 56: Select File Dialog - Open a Spreadsheet

Step 2. Once the desired spreadsheet is selected for import, click the Open button. The data are then imported into Event Capture, and will be displayed in the grid of the Spreadsheet Upload form.

4.2.2 Data Imported and Ready for Upload

Figure 57 is an example of the data that were imported from a spreadsheet into Event Capture.
4.2.3 Edit Cell Data on the Spreadsheet Upload Form

All imported data can be modified in the Spreadsheet Upload form. The information from the selected cell is displayed in the Cell Data edit box (located above the grid). The value can be changed in either the edit box or the cell itself.

The contents of an individual cell can be deleted using either the Cell Data edit box, or by highlighting the cell and pressing the <Delete> key.

To delete an ENTIRE RECORD, click once on a cell, then press the <Delete> key on the keyboard.

**Note:**
- Help is available for each column in the spreadsheet. Click on any column, and then click the Help button 🔄.

4.2.4 Modify Column Order

When the Spreadsheet Upload form is opened, the column headers are displayed in a default order. The user can change the order of the columns if the EC Template is not used.

**Step 1.** Click the Column Header button 🔄, or select the Change Column Headers option from the Spreadsheet Options menu. The Column Headers form (Figure 4.2-6) will be displayed.
Figure 58: Column Headers Form

Step 2. To change the order of the columns, highlight the column heading from the list and click either the Move Up or Move Down button.

- Repeat step 2 until the column order matches the columns order of the spreadsheet. Click the Apply button to save the column order.

Note:
- The default column header order is as follows:
  - Record Num
  - Location
  - Pat SSN
  - Pat LName
  - Pat FName
  - DSS Unit Name
  - DSS Unit Num
  - DSS Unit IEN
  - Proc Code
  - Volume
  - Ordering Sect
  - Enc Date/Time
  - Category
  - Diag Code
  - Assoc Clinic Name
  - Assoc Clinic IEN
  - Mod 1
  - Mod 2
  - Mod 3
  - Mod 4
- Mod 5
- Agent Orange
- Ion Rad
- Service Conn
- SW Asia
- Mil Sexual Trauma
- Head Neck Cancer
- Combat Vet
- SHAD
- Camp Lejeune (Note: As of Patch EC*2*131, this column is a placeholder)
- Prov 1 Name or IEN
- Prov 2 Name or IEN
- Prov 3 Name or IEN
- Prov 4 Name or IEN
- Prov 5 Name or IEN
- Prov 6 Name or IEN
- Prov 7 Name or IEN

4.2.5 Upload Imported Spreadsheet Data

To start the upload process, click the Upload Records to VistA button on the toolbar, or select the Upload Records to VistA option from the EC Upload menu.

Each record in the imported spreadsheet is validated before being filed in the Event Capture Patient file (#721).

Two levels of validation occur:

1. The first level of validation occurs within the Event Capture GUI application. A check for required information is performed, and no data transmits to VistA if this level of validation fails for any record in the spreadsheet.

2. The second level of validation occurs on the server side for each record in the spreadsheet. Records that pass this level of validation are filed in the EVENT CAPTURE PATIENT file (#721); records that fail this level of validation are not filed. Records that are filed are removed from the spreadsheet grid, leaving only those records containing errors. Each of the remaining records in the spreadsheet will have its associated error message(s) displayed in the Error Messages box. The errored record(s) can then be edited before retransmitting, or deleted.

Hint: Click on an error message to highlight the cell in the grid that most likely caused the error. This will assist in identifying, and correcting, missing or invalid data.

4.2.5.1 Spreadsheet Column Errors

The following errors may display while uploading data into Event Capture via the Spreadsheet option:

- Record Number: When transmitting records, each row in the spreadsheet needs a unique record number (i.e. 1, 2, 3, etc.). If this field is blank, VistA validation will not be done.
  - Delphi messages:
    - Error getting column with record number
    - Record number is a mandatory field
- **Location:** The location number must exist on the INSTITUTION file (#4) (also known as ^DIC(4,D0,0), where D0 is the location number).
  - VistA message:
    - Location not on INSTITUTION file (#4)

- **Pat SSN:** The Patient SSN must exist on the PATIENT file (#2) (also known as global file ^DPT). If the SSN is shorter than 9 digits, it will be filled with leading zeroes. Do not use dashes in the SSN.
  - VistA messages:
    - No SSN x-ref on PATIENT file (#2)
    - No SSN entry on PATIENT file (#2)
    - No internal entry on PATIENT file (#2) for SSN x-ref
    - SSN does not match SSN on PATIENT file (#2)

- **Patient LName and Patient FName:** The patient’s name (last name, first name) must match the name on the PATIENT file (#2) for that SSN.
  - Delphi messages:
    - Error getting column with Patient LName
    - Patient LName must be at least 2 characters long
  - VistA messages:
    - Patient last name does not match VistA
    - Patient first name does not match VistA

- **DSS Unit Name:** If this field contains a value, then it must have a “B” cross-reference on the DSS UNIT file (#724). The DSS Unit Name is not required if either the DSS Unit Number or the DSS Unit IEN contains a value.
  - VistA message:
    - Invalid DSS Unit Name

- **DSS Unit Number:** This is the Unit Number, found on the DSS UNIT file (#724). If this field contains a value, then it must have a “C” cross-reference on the DSS UNIT file (#724). The DSS Unit Number is not required if either the DSS Unit Name or the DSS Unit IEN contains a value.
  - VistA message
    - Invalid DSS Unit Number

- **DSS Unit IEN:** If this field contains a value, then it must exist on the DSS UNIT file (#724). The DSS Unit IEN is not required if either the DSS Unit Name or the DSS Unit Number contains a value.
  - VistA message
    - Invalid DSS Unit IEN

- **Proc Code:** This is the Procedure or the CPT code value (not the description). A National Procedure, Local Procedure or CPT code is valid for this column. Either the Procedure must exist in the EC NATIONAL PROCEDURE file (#725), or the CPT must exist in the CPT file (#81). In addition, the Event Code Screen must be active for the Location, DSS Unit IEN, and Procedure/CPT combination. With functionality put in place by the Code Set Versioning project, only CPT codes that are active for the date and time of the event are processed.
  - VistA messages
    - Procedure or “D” x-ref not on EC NATIONAL PROCEDURE file (#725)
• Procedure invalid for this Location and DSS Unit
• Unable to check for active EC Event Code Screen

• Volume: The volume must be a number from 1 through 99.
  – Delphi error messages
    • Error getting column with Volume number
    • Volume is a mandatory field
    • Volume has a limit of 2 digits
  – VistA messages
    • Volume must be a number from 1 to 99
    • Volume must contain numeric characters only

• Ordering Section: This is the name of the Ordering Section. Validation (against the “B” cross-reference in the MEDICAL SPECIALTY file (#723)) occurs for Ordering Section values used in the spreadsheet. If this field is blank, the program will derive the Ordering Section from the DSS UNIT file (#724) using the DSS Unit IEN. The record will then be transmitted to the Event Capture filer program.
  – VistA message
    • Invalid Ordering Section
    • Unable to determine Ordering Section

• Prov Name or IEN: This is the Provider’s last and first name as it appears in the “B” cross-reference of the NEW PERSON file (#200). If the provider also has a middle initial, then it should be included (e.g., ‘ECPROVIDER, SEVEN J’). If the system finds a partial match for the name, the application will return the provider information (provider name, IEN, specialty, subspecialty, person class), and the user can then determine which provider is correct. The Provider Name must have a “B” cross-reference in the NEW PERSON file (#200), and the person class must be active.
  – VistA messages
    • Provider has no B x-ref on NEW PERSON file (#200)
    • Unable to determine person class
    • Provider does not have an active person class

• Enc Date/Time: The Encounter Date/Time can be in any valid FileMan format.
  – Examples:
    • mm/dd/yy @hh:mm
    • mm/dd/yyyy @hh:mm
    • mm-dd-yy @hh:mm
    • mmddyy @hhmm
    • N, N-1, N-1H, etc.
      – VistA message
        • Invalid encounter date/time

• Category: The Category field can be blank. If the user enters a value, it needs to have a “B” cross-reference in the EC CATEGORY file (#726).
  – VistA message
    • Category “B” x-ref not on EC CATEGORY file (#726)
- **Diag Code**: This is the primary Diagnosis Code value. It must exist on the ICD DIAGNOSIS file (#80). With functionality put in place by the Code Set Versioning project, only ICD codes that are active for the date and time of the event process are valid. The Diagnosis Code is only required for records sent to PCE. The system ignores it otherwise.
  - VistA messages
    - Diagnosis code is required for this DSS Unit
    - Unable to retrieve Diagnosis IEN

- **Assoc Clinic**: This is the Associated Clinic name. It must have a “B” cross-reference on the HOSPITAL LOCATION file (#44), be of type “C” (clinic), and be active for that encounter date. The Associated Clinic must have conforming stop codes to be selectable. The Associated Clinic is only required for records sent to PCE; otherwise, it will be ignored.
  - VistA messages
    - Associated Clinic is required for this DSS Unit
    - Assoc Clin “B” x-ref not found on HOSPITAL LOCATION file (#44)
    - Assoc Clin not found on HOSPITAL LOCATION file (#44)
    - Associated Clinic must be of type "C" (clinic)
    - Associated Clinic inactive for this encounter date

- **Modifier (1 through 5)**: This is the Modifier, or Modifiers, associated with the procedure.
  - VistA message
  - Modifier is invalid or duplicated for the selected procedure

### 4.2.5.2 Service Connected Questions Validation

The Service Connected (SC) classification data validation and requirements are similar to those for records entered using other ECS data entry options. In order to assist the user in gathering SC information, Event Capture generates a spreadsheet of SC-related deficiencies found when transmitting the data. When a row fails validation because of SC-related deficiencies, an Export SC Errors button will appear above the Error Messages box. Click the button to generate an Excel spreadsheet, which the user can then save, print, or email to help resolve the errors.

![Figure 59: Connected Error Message and Export SC Errors Button](image_url)

![Figure 60: Export SC Errors Spreadsheet](image_url)

### 4.2.5.3 Other Error Correction Logic

- **DSS Unit IEN**: The system obtains the DSS Unit IEN by checking the DSS Unit IEN, the DSS Unit Number and the DSS Unit Name fields. If any of the three contain erroneous data, an error message is displayed and the record is not filed.
- Send to PCE: Using the DSS Unit, the application determines if the record transmits to PCE. If the DSS Unit is set to send to PCE, the application then validates the Associated Clinic and Diagnosis Code. If the DSS Unit is not set to send to PCE, the system ignores these two columns.

### 4.2.5.4 Duplicate Record Errors

If the system detects duplicate records when the spreadsheet uploads, a File Duplicate Record(s) checkbox appears on the screen. The duplicate records display in the Error Messages box. Checking the File Duplicate Record(s) box and retransmitting the spreadsheet files the duplicate records in the Event Capture Patient file (#721).

If the user-defined threshold of duplicate records is reached, a screen is displayed with the options to continue processing the records, change the threshold, or abort the upload.

**Figure 61: Duplicate Record Threshold Reached Screen**

- Continue: Resets the counter and resumes processing records.
- Change: Allows the user to change the duplicate record threshold.
- This threshold can also be altered prior to starting the upload process by selecting the Change Duplicate Threshold option from the Spreadsheet Options menu.
- Abort: Terminates the upload process.

### 4.2.6 Import a State Home Spreadsheet

State Home facilities use Excel spreadsheets for tracking patient occupancy. The State Home spreadsheet template is available for download from the State Home website (http://nonvacare.hac.med.va.gov/programs/state-homes-tools.asp). Event Capture can directly import, and upload, the data from these spreadsheets.

Steps for importing a State Home Spreadsheet:

**Step 1. Click the Open a State Home Spreadsheet button or select the Open State Home Spreadsheet option from the File menu. A standard Select File dialog will be displayed, allowing the user to select the State Home spreadsheet to be imported.**
Note:
- Multiple months of State Home data can be stored in a single spreadsheet by using tabbed worksheets to represent the various months. Only the worksheet that was active when the spreadsheet was last saved will be imported.

Step 2. Once the desired State Home spreadsheet is selected for import, click the Open button.

Step 3. A screen prompting the user for more information, including Facility Type, Location, DSS Unit, Date, and Provider(s), is displayed.
4.2.7 Upload Completion

As records are processed, the uploaded rows will be cleared from the data grid, and a progress indicator will display the number of rows uploaded and the number records in error. When all rows have been uploaded, both the data grid and the Error Messages list will be clear of all records.

Figure 64: Spreadsheet Upload Progress Indicator

4.3 Reports

The following subsections describe the reports available within Event Capture.

4.3.1 Reports Available to All Users

The following reports are available to all users (including ECMGR key holders):

- DSS Unit Activity Report
- DSS Unit Workload Report
- ECS Records Failing Transmission to PCE Report
- Event Capture Encounters Report
- Ordering Section Summary Report
- Patient Summary Report
- PCE Data Summary Report
- Procedure Reasons Report
- Provider Summary Report
- Provider (1-7) Summary Report

Figure 65: Report Selection Screen for All Users

4.3.1.1 DSS Unit Activity Report

- The report can be sorted by patient, provider or SSN.
- If more than one location has been set up, choose one or all locations.
- After previewing the report, the user will have the option to print or close the report.

Step 1. Enter a date range.
Step 2. Select one or all Location(s).
Step 3. Select one or all DSS Unit(s).
Step 4. Choose Sort Method (Patient, Provider or SSN) for the report.

Notes:
- Only the last four digits of the patient's SSN will appear on the print preview of this report.
- The column order does not change with Sort Method when exported into Excel.

Step 5. Export, Preview, Print or Cancel the report.
Figure 66: DSS Unit Activity Report Required Information

Figure 67: DSS Unit Activity Report from Print Preview
4.3.1.2 **DSS Unit Workload Report**

- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
- After previewing the report, the user will have the option to print or close the report.

**Step 1.** Enter a date range.

**Step 2.** Select one or all location(s).

**Step 3.** Select one or all DSS Unit(s).

**Step 4.** Export, Preview, Print or Cancel the report.
4.3.1.3 ECS Records Failing Transmission to PCE Report

- Locations, DSS Units, procedures, five-character EC National Codes (when applicable) and categories must be defined before using this option.
- After previewing the report, the user has the option to print or close the report.

**Step 1.** Select the date range.

**Step 2.** Export, Preview, Print or Cancel the report.
Figure 72: ECS Records Failing Transmission to PCE Report Required Fields

![Figure 72: ECS Records Failing Transmission to PCE Report Required Fields](image1)

Figure 73: ECS Records Failing Transmission to PCE Report from Print Preview

![Figure 73: ECS Records Failing Transmission to PCE Report from Print Preview](image2)
### 4.3.1.4 Event Capture Encounters Report

- Displays and counts the unique occurrences by patient and DSS Unit during a selected date range. It also enables sorting by patient or by provider.
  - When sorted by Patient shows the number of unique occurrences for the Patient across the date range that is selected.
  - When sorted by Provider shows the number of unique occurrences for the Provider across the date range that is selected.
- Includes the fields Patient Name, SSN (last 4 digits), Inpatient or Outpatient (I/O), Date/Time, Provider #1, DSS Unit and Volume.
- After previewing the report, the user has the option to print or close the report.

**Step 1. Select a date range.**

**Step 2. Select a Location.**

**Step 3. Select one, all or multiple DSS Unit(s).**

**Step 4. Select Sort Method (Patient or Provider).**

**Step 5. Export, Preview, Print or Cancel the report.**

**Notes:**

- Only the last four digits of the patient’s SSN will appear on the print preview of this report.
- The column order does not change with Sort Method when exported into Excel.
- A report timeout warning and a message dialog are displayed when All Locations, All DSS units or large date ranges are selected.
Figure 75: Event Capture Encounters Report Required Fields

![Event Capture Encounters Report](image)

Figure 76: Event Capture Encounters Report Timeout Warning

![Timeout Warning](image)
Figure 77: Event Capture Encounters Report Sorted by Patient

![Event Capture Encounters Report Sorted by Patient](image)

Figure 78: Event Capture Encounters Report Sorted by Provider

![Event Capture Encounters Report Sorted by Provider](image)

Figure 79: Event Capture Encounters Report from Export

![Event Capture Encounters Report from Export](image)
4.3.1.5 Ordering Section Summary Report

- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
- After previewing the report, the user will have the option to print or close the report.

Step 1. Enter a date range.
Step 2. Select an Ordering Section.
Step 3. Select a specific or all Location(s).
Step 4. Select one, multiple, or all DSS Unit(s).
Step 5. Export, Preview, Print or Cancel the report.

Figure 80: Ordering Section Summary Report Required Information
4.3.1.6 Patient Summary Report

- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
- The user can choose to include Procedure Reasons (EVENT CAPTURE PATIENT file (#721)) on the report. Up to three reasons will be included.
- The “Display Reasons on this report” will clear when the user selects another report or upon exiting the screen.
- After previewing the report, the user will have the option to print or close the report.

**Step 1.** Enter a date range.
**Step 2.** Use the Patient Identifier field to select a patient.
• Enter one of the following:
  – Patient Name (whole or partial, last name first)
  – Social Security Number
  – Last four digits of the Patient Social Security Number
  – First character of Last Name plus the last four digits of the SSN with no spaces

• Press <Enter> on the keyboard or click the Search button.
• Choose from the list of patients displayed.

Step 3. Click the Display Reasons on this report checkbox to include Procedure Reasons in the report.

Step 4. Export, Preview, Print or Cancel the report.

Figure 83: Patient Summary Report Required Information without Reasons
Figure 84: Patient Summary Report from Report Preview without Reasons

Figure 85: Patient Summary Report from Export without Reasons
Figure 86: Patient Summary Report Required Information with Reasons

```
<table>
<thead>
<tr>
<th>Event Capture - Patient Summary Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Report</strong></td>
</tr>
<tr>
<td>- DSS Unit Activity Report</td>
</tr>
<tr>
<td>- DSS Unit Workload Report</td>
</tr>
<tr>
<td>- ECS Records Failing Transmission to PCE Report</td>
</tr>
<tr>
<td>- Event Capture Encounters Report</td>
</tr>
<tr>
<td>- Ordering Section Summary Report</td>
</tr>
<tr>
<td>- Patient Summary Report</td>
</tr>
<tr>
<td>- PCE Data Summary Report</td>
</tr>
<tr>
<td>- Procedure Reasons Report</td>
</tr>
<tr>
<td>- Provider Summary Report</td>
</tr>
<tr>
<td>- Provider (1-7) Summary Report</td>
</tr>
<tr>
<td>- Disabled Category and Procedure Summary</td>
</tr>
<tr>
<td>- DSS Units with any Associated Step Code Errors</td>
</tr>
<tr>
<td>- DSS Unit User Access Report</td>
</tr>
<tr>
<td>- Event Code Screens with CPI Codes Report</td>
</tr>
<tr>
<td>- Event Code Screens with Inactive Default Associated Clinic</td>
</tr>
<tr>
<td>- Inactive Person Class Report (IPG)</td>
</tr>
<tr>
<td>- Inactive Person Class Report</td>
</tr>
<tr>
<td>- National/Local Procedure Codes with Inactive CPT Codes</td>
</tr>
<tr>
<td>- National/Local Procedure Report</td>
</tr>
<tr>
<td>- Print Category and Procedure Summary (Report)</td>
</tr>
<tr>
<td>- Send No Records DSS Units Report</td>
</tr>
</tbody>
</table>
```

**From Date:** 01 APR 2016  
**Through Date:** 20 JUN 2016  
**Patient Identifier:** ECPATIENT,FOUR  (000-00-2587) DOB: 1/1/1948

Figure 87: Patient Summary Report from Report Preview with Reasons

```
EVENT CAPTURE PATIENT SUMMARY FOR ECPATIENT,FOUR  
FROM Apr 01, 2016 TO Jun 20, 2016  
Run Date: JUN 20, 2016 18:23:05

PROCEDURE DATE/TIME  
- 89460 SELFT-MGMT EDUC/TLTH 8-8 PT (1)  
- 79 UNRELATD PROC OR SERVICE BY SAME PTS DURING POSTOP PERIOD  
- CHAPLAIN  
- MEDICAL MEDIA  
- CHAPLAIN  
- CHAPLAIN  

PROCEDURE REASON(S)  
- ORDERING SECTION  
- SECTION  
- PROVIDER
```

Volume totals may represent days, minutes, numbers of procedures and/or a combination of these.
4.3.1.7 PCE Data Summary Report

- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated descriptions are reflective of the date the event occurred.
- After previewing the report, the user has the option to print or close the report.

**Step 1. Enter a date range.**

**Step 2. Use the Patient Identifier field to select a patient.**

- Enter one of the following:
  - Patient Name (whole or partial, last name first)
  - Social Security Number
  - Last four digits of the Patient Social Security Number
  - First character of Last Name plus the last four digits of the SSN with no spaces

- Press <Enter> on the keyboard or click the Search button.
- Choose from the list of patients displayed.

**Step 3. Export, Preview, Print or Cancel the report.**
Figure 89: PCE Data Summary Report Required Information

Figure 90: PCE Data Summary Report from Print Preview
4.3.1.8 Procedure Reasons Report

- Locations, DSS Units, procedures, and procedure reasons must be defined before using this option.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated descriptions are reflective of the date the event occurred.
- After previewing the report, the user has the option to print or close the report.
- This report is exportable into an Excel spreadsheet. The tab in Excel is titled “Reasons” followed by the Date Range the user selected.

Step 1. Select a date range.

Step 2. Select one, all or multiple Location(s).

Step 3. Select one, all or multiple Procedure Reasons.

Step 4. Select one, all or multiple DSS Unit(s).

Step 5. Export, Preview, Print or Cancel the report.
Figure 92: Procedure Reasons Report Required Information

![Procedure Reasons Report Required Information](image)

Figure 93: Procedure Reasons Report from Print Reviews

![Procedure Reasons Report from Print Reviews](image)
4.3.1.9 Provider Summary Report

- Locations, DSS Units, categories, procedures and procedure reasons must be defined before generating this report.
- If Procedure Reason #1 is not listed, the report prints “Reason Not Defined”.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
- After previewing the report, the user will have the option to print or close the report.

Step 1. Enter a date range.
Step 2. Select one or all Location(s).
Step 3. Select one or all DSS Unit(s).
Step 4. Export, Preview, Print or Cancel the report.

Figure 94: Procedure Reasons Report from Export

<table>
<thead>
<tr>
<th>LOCATION</th>
<th>DSS UNIT</th>
<th>DSS UNIT EN</th>
<th>REASON TEXT</th>
<th>REASON #</th>
<th>PROC CODE</th>
<th>PROCEDURE NAME</th>
<th>SSN</th>
<th>PATIENT</th>
<th>DATE/TIME</th>
<th>PROVIDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALBANY</td>
<td>ALBANY</td>
<td>11</td>
<td>BECAUSE CYNTHIA SAID SO 3</td>
<td>11740</td>
<td>XX</td>
<td>DRAIN BLOOD FROM UNDER NAIL</td>
<td>xxx</td>
<td>XXXXX</td>
<td>1/14/15 00:00</td>
<td>AGABA,OU</td>
</tr>
</tbody>
</table>

Figure 95: Provider Summary Report Required Information
4.3.1.10 Provider (1-7) Summary Report

- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
- This report provides the ability to view up to seven provider numbers for providers within a Location/DSS Unit.
- Summarizes the workload of providers for a selected date showing how many times a specific procedure was performed on a patient with the selected provider as Provider 1, Provider 2, through Provider 7.
- After previewing the report, the user has the option to print or close the report.

Step 1. Enter a date range.
Step 2. Enter the name of a Provider.
Step 3. Export, Preview, Print or Cancel the report.
Figure 98: Provider (1-7) Summary Report Required Information

Figure 99: Summary Report from Print Preview
4.3.2 Reports Available to ECMGR Key Holders Only

The following reports are available only to ECMGR key holders:

- Category Report
- Disabled Category and Procedure Summary
- DSS Units with any Associated Stop Code Errors
- DSS Units/Event Code (EC) Screens for Selected Procedure Code Report
- DSS Unit Users Access Report
- Event Code Screens with CPT Codes Report
- Event Code Screens with Inactive Default Associated Clinic
- Inactive Person Class Report (IPC)
- National / Local Procedure Codes with Inactive CPT Codes
- National / Local Procedure Report
- Print Category and Procedure Summary (Report)
- Send No Records DSS Units Report

As shown in the figure below, ECMGR reports are displayed in the Select Report area, below the asterisk line.
4.3.2.1 Category Report

- Use the Category - Add or Update Categories option to create categories before selecting this report.
- This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
- After previewing the report, the user has the option to print or close the report.

Step 1. Choose a status of Active, Inactive or Both.
Step 2. Export, Preview, Print or Cancel the report.
Figure 102: Category Report Required Fields

Figure 103: Category Report (Active) from Print Preview
Figure 104: Category Report (Active) from Export

Figure 105: Category Report (Inactive) from Print Preview

Figure 106: Category Report (Inactive) from Export
4.3.2.2 Disabled Category and Procedure Summary

- This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
- This report provides a list of ECS categories that have been disabled for one or all DSS Units for a specified location. Event Code Screens that are comprised of DSS Units that allow category use, and have Event Code Screens defined using the disabled category, will appear on this report.
- The report provides the Location, Service, DSS Unit IEN and name, Send Status and DSS Dept.
- The exported data will include those fields listed above, as well as the DSS Unit Inactive, Disabled Category, CPT Code, Procedure Code, Procedure Name, Synonym, Clinic IEN, Clinic, Clinic Stop Code, Credit Stop Code and CHAR4 Code.
- After previewing the report, the user has the option to print or close the report.

Step 1. **Select the report.**
Step 2. **Select All Locations, One Location, or Multiple Locations.**
Step 3. **Export, Preview, Print or Cancel the report.**
Figure 109: Disabled Category and Procedure Summary Required Fields
### 4.3.2.3 DSS Units with Any Associated Stop Code Errors Report

- This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
- The Event Capture software restricts DSS-only workload to use valid Stop Codes.
To assist sites in locating DSS Units that have invalid associated Stop Codes, the DSS Unit list with Secondary Associated Stop Codes option is provided. This may be attached as a secondary menu option and run as often as needed. The only prompt is for Device.

This report provides a list of DSS Units with any error with the Associated Stop Code.

The report provides the DSS Unit IEN and name, Associated Stop Code IEN and name and the reason for the error.

After previewing the report, the user has the option to print or close the report.

Select an active non-secondary Stop Code to replace the Stop Code in the DSS Unit set up.

**Step 1.** Select the report.

**Step 2.** Export, Preview, Print or Cancel the report.

**Figure 112: DSS Units with Any Associated Stop Code Errors Required Fields**
4.3.2.4 DSS Units/Event Code (EC) Screens for Selected Procedure Code Report

- Only holders of the ECMGR security key can run this report.
- After previewing the report, the user has the option to print or close the report.
- This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “Selected Procedure Code”.

**Step 1. Select one, all or multiple Location(s).**

**Step 2. Select a Procedure.**

**Step 3. Export, Preview, Print or Cancel the report.**
Figure 115: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report

Figure 116: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from Print Preview
4.3.2.5 **DSS Unit User Access Report**

- This report is also accessible from the Grant Users Access menu option.
- After previewing the report, the user has the option to print or close the report.
- This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “DSS Unit User Access Report”.

**Step 1. Select a Location.**

**Step 2. Select one, all or multiple DSS Units.**

**Step 3. Export, Preview, Print or Cancel the report.**
4.3.2.6 Event Code Screens with CPT Codes Report

- Users can print, preview or export Event Code Screens with active and/or inactive CPT codes for one or all DSS Unit(s).
  - For previewing or printing the report, when Both is selected for Active and Inactive CPT codes, all inactive CPT codes are flagged with an “I” indicator.
  - For exporting the report, all Inactive CPT codes are flagged with an “**Inactive**” indicator.
- Users must have the Management Security ECMGR key to access this report.
- After previewing the report, the user has the option to print or close the report.

**Step 1.** Select one or all Location(s).

**Step 2.** Select one or all DSS Unit(s).

**Note:**
- If All is selected for the DSS Unit, the Category will also be All and will be disabled.

**Step 3.** Select a Category.

**Note:**
- Categories only appear if the Event Code Screen uses categories to group procedures.

**Step 4.** Select Active, Inactive or Both (Active and Inactive) for CPT Codes.

**Step 5.** Export, Preview, Print or Cancel the report.

**Note:**
- The tab of the report indicates whether the exported report shows only active, only inactive, or both active and inactive CPT codes.
Figure 121: Event Code Screens with CPT Codes Report Required Fields

Figure 122: Event Code Screens with CPT Codes Report from Print Preview (Both Active and Inactive CPT Codes Selected)
4.3.2.7 **Event Code Screens with Inactive Default Associated Clinic Report**

- Only holders of the ECMGR security key can run this report.
- After previewing the report, the user has the option to print or close the report.
- This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “Inactive Default Clinic”.

**Step 1.** Select one, all or multiple Location(s).

**Step 2.** Select one, all or multiple DSS Unit(s).

**Step 3.** Export, Preview, Print or Cancel the report.
4.3.2.8 Inactive Person Class Report (IPC) Report

- This report shows providers who do not have a Person Class specified in the NEW PERSON file (#200) or who do not have an active Person Class in the NEW PERSON file (#200) for the date of the procedure.
- After previewing the report, the user has the option to print or close the report.

**Step 1.** Enter a date range.
**Step 2.** Select Sort by Patient or Sort by Procedure.
**Step 3.** Export, Preview, Print or Cancel the report.

**Note:**
- The column order does not change with Sort Method when exported into Excel.
Figure 127: Inactive Person Class Report Required Information
4.3.2.9 National/Local Procedure Codes with Inactive CPT Codes Report

- This report provides a list of National and Local Procedure Codes with inactive CPT codes from EC NATIONAL PROCEDURE file (#725).
- Users must have the Management Security ECMGR key to access this report.
- After previewing the report, the user has the option to print or close the report.

**Step 1.** Select the report.

**Step 2.** Export, Preview, Print or Cancel the report.
Figure 130: National/Local Procedure Codes with Inactive CPT Codes Requirements

![Image of the user interface for selecting reports in Event Capture]

This report requires no selection criteria.

Figure 131: National/Local Procedure Codes with Inactive CPT Codes Report Print Preview

![Image of the report preview window showing inactive CPT codes]

Figure 132: National/Local Procedure Codes with Inactive CPT Codes Report from Export

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>National/Local Procedure Codes with Inactive CPT Codes</td>
<td>NATIONAL NUMBER</td>
<td>NATIONAL NAME</td>
<td>CPT CODE</td>
</tr>
<tr>
<td>SW015</td>
<td>PSYCHSOC TX/PSYCHOTHERAPY OPT 75-80 MIN</td>
<td>90808</td>
<td>01/01/13</td>
</tr>
<tr>
<td>SP015</td>
<td>SENSOREY AIDS ASSESSMENT, 16 MIN</td>
<td>92506</td>
<td>01/01/14</td>
</tr>
<tr>
<td>SP035</td>
<td>COGNITIVE TREATMENT</td>
<td>97770</td>
<td>04/01/01</td>
</tr>
<tr>
<td>SP037</td>
<td>ADD FITTING/ORIENTATION</td>
<td>97703</td>
<td>01/01/06</td>
</tr>
<tr>
<td>SD015</td>
<td>VOICE PROSTHESIS MODIFY, 16 MIN</td>
<td>92595</td>
<td>01/01/06</td>
</tr>
<tr>
<td>80808</td>
<td>BRIEF TONE TESTING</td>
<td>92595</td>
<td>01/01/06</td>
</tr>
<tr>
<td>90808</td>
<td>DIAGNOSTIC TESTING</td>
<td>92595</td>
<td>01/01/06</td>
</tr>
<tr>
<td>FL082</td>
<td>PC HOME VISITS, 10 MIN</td>
<td>90589</td>
<td>01/01/19</td>
</tr>
</tbody>
</table>
4.3.2.10 National/Local Procedure Report – Active Procedures

- Use the Procedure - Add or Update Local Procedures option to create local procedures before using this option.
- This report is accessible to Management users only. For users without the Management Security key (ECMGR), this report will not appear.
- After previewing the report, the user has the option to print or close the report.

Step 1. Click the Active button.
Step 2. Choose a Preferred Report (National, Local or Both).
Step 4. Export, Preview, Print or Cancel the report.

Figure 133: National/Local Procedure Report (Active) Requirements
4.3.2.11 National/Local Procedure Report – Inactive Procedures

- Use the Procedure - Add or Update Local Procedures option to create local procedures before using this option.
- This report is accessible to Management users only. For users without the Management Security key (ECMGR), this report will not appear.
- After previewing the report, the user has the option to print or close the report.

**Step 1.** Click the Inactive button.

**Step 2.** Export, Preview, Print or Cancel the report.

**Note:**
- If the report is marked as Inactive, the preferred report and sort method will be disabled.
Figure 136: National/Local Procedure Report (Inactive) Required Fields

Figure 137: National/Local Procedure Report (Inactive) from Print Preview
4.3.2.12 Print Category and Procedure Summary (Report)

- Use the DSS Unit - Add or Update DSS Units option to create DSS Units categories before using this option.
- Use the Category - Add or Update Categories option to create categories before using this option.
- Use the Procedure - Add or Update Local Procedures option to create procedures before using this option.
- This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
- After previewing the report, the user has the option to print or close the report.

Step 1. Select one or all Location(s).
Step 2. Select one or all DSS Unit(s).

**Note:**
- If “All” is selected for the DSS Unit, the Category will also be “All” and will be disabled.

Step 3. Select a Category.
Step 4. **Note:** Categories only appears if the Event Code Screen uses categories to group procedures.
Step 5. Select Active, Inactive or Both (Active and Inactive) EC Code Screens.
Step 6. Export, Preview, Print or Cancel the report.
Figure 139: Print Category and Procedure Summary (Report) Required Fields
4.3.2.13 Send No Records DSS Units Report

- This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
- Lists active DSS Units with send to PCE status of Send NO RECORDS.
- Includes DSS Unit Name and IEN, Associated Stop Code (and Credit Stop and/or CHAR4 Code if present).
- After previewing the report, the user has the option to print or close the report.

Step 1. Export, Preview, Print or Cancel the report.
Figure 142: Send No Records DSS Units Report Required Fields

Figure 143: Send No Records DSS Units Report from Print Preview
4.4 Management Menu

The Event Capture Management Menu is available for users with the ECMGR security key. The main menu in the Management Menu provides the following management functions:

- Location – Update Location Information
- DSS Unit – Add or Update DSS Units
- Access by User – Grant Access to DSS Units by User
- Category – Add or Update Categories
- Procedure – Add or Update Local Procedures
- Reason – Add or Update Procedure Reasons
- Event Code Screen – Add or Update Event Code Screens
- Inactivate EC Screen – Identify/Inactivate Multiple Event Code Screens
4.4.1 Location – Update Location Information

Before the User Starts

- Location selected must be in the INSTITUTION file (#4).
- Locations must be created with this option before the user can establish DSS Units. No further options are functional until the user creates an Event Capture location.

What the User Will See

- Selecting the Location - Update Location Information option opens a screen that displays all the known location names, State, Facility Type, Station Number and Current Status in matrix form. The column width is adjustable.
- From the first screen, double-click on a row or highlight a row and click the Update button.

Figure 146: Management Menu (Locations) Screen

![Management Menu (Locations) Screen]

After selecting a location, an edit screen will appear, allowing the user to create the location as a current Event Capture location, or to remove the selected location.

Figure 147: Edit Location Screen

![Edit Location Screen]
The rows can be sorted by using the Sort menu, or by clicking on the column header.

**Figure 148: Sort Menu Options**

To create a current location, click the checkbox labeled “Create as current Event Capture location” and click the OK button. The location is “flagged” as active for use in the Event Capture software.

**Figure 149: Creating a Current Location**

To remove a current location, click the checkbox labeled “Remove as current Event Capture location” and click the OK button. The location is “flagged” as inactive for use in the Event Capture software.

**Figure 150: Removing a Current Location**

Click the Export button to export the Locations listing to Excel. The tab in Excel is titled “ECS Location Table Export.”
4.4.2 DSS Unit – Add or Update DSS Units

Before the User Starts

- Use the Location - Update Location Information option to create an Event Capture location before using this option.
- A prompt displays a notification to enter an Associated Stop Code only if the “Send to PCE” flag is set to NO or NULL.
- No further options are functional until DSS Units are created.

What the User Will See

- After selecting DSS Unit from the Management Menu, the first screen will display a list of DSS Units. Click the Update button to update an existing DSS Unit or click the Add button to add a new DSS Unit.
The DSS Units screen contains the following columns:

- DSS Unit Name
- Unit IEN
- Active Status for DSS Unit (Yes or No)
- The PCE column reflects if workload is set to pass to PCE. Values include:
  - ALL – Send all records
  - Outpatient – Send outpatient only
  - No – Send no records.
- DSS Department
- Service
- Medical Specialty
- Cost Center

Using the Find button, the user can search by DSS Unit, DSS Dept. and Unit IEN. Type in a partial search string, click Find and the screen will position to the first entry matching the search criteria.

The Print button enables users to print the report.

The Export button enables users to export the data to an Excel spreadsheet.
Click Update to update an existing DSS Unit or click Add to add new one. The Edit a DSS Unit or Add a DSS Unit screen will appear.

Below are the element name and description for each field that appears on the Add or Edit DSS Unit screen:

<table>
<thead>
<tr>
<th>Element Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSS Unit Name</td>
<td>The name of the DSS Unit being created</td>
</tr>
<tr>
<td>DSS Dept. and DSS Unit IEN</td>
<td>The number to identify this DSS unit locally at the user’s site (1 to 14 characters) - The same DSS Unit number can be used for more than one DSS Unit</td>
</tr>
<tr>
<td>Service</td>
<td>The service associated with this DSS Unit - from the SERVICE/SECTION file (#49)</td>
</tr>
<tr>
<td>Element Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Medical Specialty</td>
<td>The medical specialty associated with this DSS Unit - from the MEDICAL SPECIALTY file (#723)</td>
</tr>
<tr>
<td>Cost Center</td>
<td>The cost center associated with this DSS Unit - from the COST CENTER file (#420.1). Cost centers are defined in MP4-Part V, Appendix B of the Fiscal Service cost manuals.</td>
</tr>
</tbody>
</table>
| DSS Unit Status    | Active - Lists Active Event Code Screens  
|                    | Inactive - Lists Inactive Event Code Screens                                                                                                      |
| Event Code Screens | Reactivate  
|                    | Remain Inactive                                                                                                                                       |
| Default Date / Time| NOW – The current date and time will populate during data entry  
|                    | NONE – No default date and time will be populated during data entry. The user is required to enter the date and time of the procedure.                                                                    |
| Allow Category Use | YES – Use categories to group procedures during data entry  
|                    | NO – Do not use categories to group procedures during data entry                                                                                   |
| Send to PCE        | Defines the method used to send the user’s data to PCE for the DSS Unit being created.  
|                    | All Records - Send All Records  
|                    | No Records - Send No Records                                                                                                                         |
| Associated Stop    | Select the Stop Code associated with this DSS Unit. Be sure to select an active Stop Code.                                                                                                                 |
| Code               | Credit Stop Code Select the Credit Stop Code associated with this DSS Unit                                                                                                                                  |
| CHAR4 Code         | Select the CHAR4 Code associated with this DSS Unit                                                                                                                                                    |

On add or edit screens, the status defaults to Active. The Allow Category Use field defaults to No, but the user can select Yes. The Send to PCE option can be setup for No Records, and the Associated Stop Code field is enabled. A search for the Associated Stop Code can occur by description or code, resulting in both the description and the code displaying. When Send to PCE is set to All Records, the Associated Stop Code field will not be visible. All other default options can be changed.

### 4.4.2.1 Add a DSS Unit

**Step 1.** Click on the Add button.  
**Step 2.** Enter a DSS Unit Name.  
**Step 3.** Enter a DSS Dept.  
**Step 4.** Select a Service from the list provided.  
**Step 5.** Select a Medical Specialty from the list provided.  
**Step 6.** Select a Cost Center from the list provided.  
**Step 7.** Select the DSS Unit Status  
**Step 8.** Choose the Date / Time Default.  
**Step 9.** Choose whether or not to Allow Category Use.  
**Step 10.** Choose which records will be sent to PCE.  
**Step 11.** Click the OK button when selections are complete.
4.4.2.2 Update a DSS Unit

Step 1. Select a DSS Unit from the list of DSS Units and click the Update button.

Step 2. The Edit DSS Unit screen will be displayed. On this screen, the DSS Unit Name, DSS Dept., Service, Medical Specialty, Cost Center, DSS Unit Status, Event Code Screens status, Default Date / Time, Send to PCE, Allow Category Use, Associated Stop Code, Credit Stop Code, and CHAR4 Code fields can be updated.

Notes:
- DSS Unit Status may be Active or Inactive.
- The Event Code Screens options are different when Inactive is chosen for DSS Status.

Figure 155: Original Active/Inactive Status

<table>
<thead>
<tr>
<th>DSS Unit Status</th>
<th>Event Code Screens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Reactivate</td>
</tr>
<tr>
<td>Inactive</td>
<td>Remain Inactive</td>
</tr>
</tbody>
</table>

When the DSS Unit Status is changed, the Event Code Screens options also change.

Figure 156: Change from Active to Inactive or Inactive to Active

<table>
<thead>
<tr>
<th>DSS Unit Status</th>
<th>Event Code Screens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Retain</td>
</tr>
<tr>
<td>Inactive</td>
<td>Inactivate</td>
</tr>
</tbody>
</table>

- If the user selects Retain, the DSS Unit will remain active.
- If the user selects Inactivate, the DSS Unit that was active will be inactivated.
- Once a DSS Unit is inactive, the user can activate the DSS Unit again by selecting Reactivate.
- If the user selects Remain Inactive, the DSS Unit will remain inactive.

Step 3. Click the OK button when selections are complete.

4.4.2.3 To Grant Access to a DSS Unit

From the Add or Update DSS Units screens, the user has the option to give specific users access to the DSS Unit being added or edited.

Step 1. Click on the Access button at the bottom of the Add or Edit DSS Unit screen.

Step 2. The Grant Access to DSS Unit Screen has Include and Exclude fields.

Step 3. The user can type the starting characters of the last name in the upper portion of the Excluded list box, or simply scroll through the list to search for a last name. The Excluded list box contains the names of all active VistA users at the site.

Step 4. The DSS manager grants access to a specific DSS unit by moving a user to the Included list box, either by highlighting a name in the Excluded list box and clicking the Include button, or by simply double-clicking the name in the Excluded list box. Access is denied by moving the user to the Excluded list box, either by highlighting a name in the
In the Included list box and clicking the Exclude button, or by simply double-clicking the name in the Included list box.

**Step 5.** Clicking the Apply button will save the changes and allow the user to grant access to additional users; clicking the OK button will save the changes and return the user to the previous screen.

**Note:**

- The IEN and Person Class/Classification for a selected user appear below its associated Excluded or Included list box.

---

**Figure 157: Grant Access to DSS Unit Screen**

---

**Note:**

- Information has been deleted intentionally to preserve privacy

### 4.4.2.4 To Disable Categories for a DSS Unit

**Step 1.** Select a DSS Unit which allows categories from the list of DSS Units and click the Update button.
Step 2. The Edit DSS Unit screen will be displayed. In the Allow Category Use section, click the No radio button, then click the Ok button.

Figure 159: Allow Category Use Set to No

Step 3. A warning pop up window appears stating that if you disable the categories for this DSS Unit, this setting cannot be re-instated. Click Yes.

Figure 160: Disable Category Warning Pop Up Message
Step 4. On the Edit DSS Unit screen, the Event Code Screens section shows “None” listed in the Categories column. The Allow Category Use section is now disabled.

Figure 161: Edit DSS Unit Screen After Disabling Categories

Step 5. Click Ok to return to the Management Menu [DSS Units] screen.

Note:

- Once categories are disabled for a DSS Unit, any fields for entering category information for that DSS Unit will be disabled on all Event Capture screens
- Once categories are disabled for a DSS Unit, any previously entered workload will remain available for viewing and editing
- A report is available to Management users which lists all DSS Units that have changed from Allowed to Disabled Categories. (See Section 4.3.2.2)

4.4.3 Access by User - Grant Access to DSS Units by User

Before the User Starts

- Use extreme caution when utilizing this option. Removing access to a specified DSS Unit for all users and inactivating the DSS Unit is not recommended without the permission of the associated service.
- Contact each service for a list of its Event Capture users and the DSS Units for which they enter data.
- The user must have access to a given DSS Unit before procedure data can be entered.
- Access can be provided to all DSS Units by assigning the ECALLU security key to a specified user (normally the DSS Manager or designee) using the Allocation of Security Keys option in the Key Management Menu under the Menu Management Menu.
4.4.3.1 **To Assign User Access to DSS Units**

**Step 1.** Click on the Access by User - Grant Access to DSS Units by User button.

**Step 2.** When the screen opens, a list of users appears at the top of the box. Select a user.

**Figure 162: Grant Access to DSS Units by User**

![Image](image1.png)

**Step 3.** Select the names of the DSS Unit(s) by highlighting the particular unit and clicking on the Include button.

**Figure 163: Grant Access to DSS Units by User**

![Image](image2.png)
Step 4. Click the Apply button to apply the changes and continue working, or click the OK button to apply the changes and exit the screen.

Note:
- The user can print a list of users identified as having access to a given DSS Unit by clicking the Print button.

4.4.4 Category - Add or Update Categories

Before the User Starts
- The user can ignore this option if the site’s DSS Units are defined for use without categories.
- Categories cannot be deleted, but this option can be used to inactivate or reactivate them.

What the User Will See
- After selecting Category – Add or Update Categories from the Management Menu, the first window displays a list of Category Names, the Date created, and the Inactivation Date.

Figure 164: Categories Main Screen on Management Menu

- The second screen enables the user to add a Category or to update a selected Category. The second screen contains fields called Category Name and Status.

4.4.4.1 To Add or Update Categories

Step 1. To add a new local category:
- Click the Add button on the screen, or click the Add menu item in the Edit menu. The Status field defaults to “Active”.

-
• Enter the name of the category to be added, then click the OK button.

Step 2. To update an existing local category:
• From the list of categories, select the category record to modify and click Update. The Update Category screen is displayed.
• Change the category to its new status by clicking Active or Inactive. Click the OK button to file the change and return to the previous screen.

Step 3. The Categories screen on the Management Menu will reflect the changes made. If the category was inactivated, the Inactivation Date will display the current date.

Step 4. The Export button enables users to export the data to an Excel spreadsheet.

4.4.5  Procedure - Add or Update Local Procedures

Before the User Starts
Before using this option, print the National/Local Procedure Report from the Reports menu of the Event Capture Main Menu to print a list of procedures with their associated CPT codes. This report can be lengthy if it includes national procedures. This should be queued to print to a device during non-peak hours.

- Enter an associated CPT code to pass local procedures to the PCE software.
- A local procedure code number is required for any new local procedure.
- The local number code must be five characters in length, starting with an uppercase alpha character, followed by four alpha or numeric characters.
- With functionality put in place by the Code Set Versioning project, only active CPT codes are made available, and are based on the date a local procedure is added.

What the User Will See

- After selecting Procedure - Add or Update Local Procedures from the Management Menu, the first screen displays a list consisting of Procedure Name, Number, CPT Code and CPT Description, and Active status.

![Figure 168: Procedures Main Screen Management Menu](image)

- The detail screen enables the user to add a Local Procedure. This screen contains the following fields: Procedure Name, Procedure Number, CPT Code and Description, and Status.
• Local procedures cannot be deleted, but this option can be used to inactivate or reactivate them.
• The CPT Code and Description field contains CPT Code look-up functionality. The user can search for an existing CPT Code by code, a portion of the code, or a part of the description.
• When attempting to file a new Local Procedure, the system compares the new procedure to the National Procedure code file to prevent duplication. A message is displayed, and the local procedure is not added.

Instructions to Add or Update Local Procedures

**Step 1. To add a new local procedure:**

- Click the Add button on the screen, or click the Add menu item in the Edit menu.
- Enter the new local Procedure Name.
- Enter the local Procedure Number.
- Enter the CPT Code if the data will transmit to the PCE software.
- Click the OK button. The new local procedure has been added.
Step 2. **To update an existing local procedure:**

- Highlight the existing record and click the Update button, or double-click the row.
- Edit the Procedure Name, Procedure Number, CPT Code and Description, and/or Status.
- Click the OK button. The local procedure has been updated.
Figure 173: Update After Editing a Local Procedure

- Click the Export button to export the Procedures listing to Excel; the tab in Excel is titled “ECS Procedure Table Export”.

Figure 174: Export of Procedures into Excel

4.4.6 Reason - Add or Update Procedure Reasons

Before the User Starts

- Users with the ECMGR security key can activate or inactivate existing reasons. If a reason is listed as inactive, it will not appear on the dropdown list for reasons on any screen.
- Event Capture managers can add a new reason using the Event Capture – New Reason screen.

What the User Will See
• After selecting Reason – Add or Update Procedure Reasons from the Management Menu, the first screen displays a list of Active Reasons and Inactive Reasons.

**Figure 175: Management Menu (Reasons) Screen**

4.4.6.1 **Activate Reasons**

• Highlight one or more items from the Inactive Reasons list box and click the Activate button. To move more than one reason, click and hold the <Ctrl> key and then highlight additional items.

**Figure 176: Reasons Screen with Inactive Reasons Highlighted**

• The Inactive Reason(s) selected will appear in the Active Reasons column when the Activate button is clicked.
Figure 177: Reasons Screen with Inactive Reasons Moved to the Active Column

- Click the OK or Apply button to update the reason(s). A confirmation prompt will appear. Click the Yes button to save the changes.

Figure 178: Confirmation Prompt

4.4.6.2 Inactivate Reasons

Step 1. Highlight item(s) from the Active Reasons list box and click the Inactivate button.

- To move more than one reason, click and hold the <Ctrl> key and then highlight additional items.

Figure 179: Reasons Screen with Active Reasons Highlighted

- The Active Reason(s) selected will appear in the Inactive Reasons column when the Inactivate button is clicked.

Figure 180: Reasons Screen with Active Reasons Moved to the Inactive Column

Step 2. Click the OK or Apply button to update the reason(s). A confirmation prompt will appear. Click the Yes button to save the changes.
4.4.6.3 Add a New Reason

Step 1. Click the Add button. The Event Capture – New Reason screen will appear.

Step 2. Type the value of the new reason. Click the OK button to add the reason to the Active Reasons column. Click the Cancel button to exit the screen without saving the record.

4.4.7 Event Code Screen: Add, Update, or Copy Event Code Screens

Before the User Starts

- Use the Location - Update Location Information option to create an Event Capture location before using this option.
- Use the DSS Unit - Add or Update DSS Units option to establish DSS Units before using this option.
- Event Code screens must be defined before entering any Event Capture data.
- A prompt for Category occurs only if the Event Code screen uses categories to group procedures.
• The user must define an active Associated Clinic and CPT code to pass Event Code procedures to PCE.
• With functionality put in place by the Code Set Versioning project, only active CPT codes can be selected and they will be based on the date the event code screen is being set up.
• The Event Code screen enables the use of characters “/” and “-” in the search field.
• The Associated Clinic on the Event Code screen is not auto-populated.
• The Print and Export buttons have been added to the Event Code Screen.
• Users with the ECMGR key will be able to copy EC screens to another DSS Unit.

What the User Will See

• After selecting Event Code Screen - Add or Update Event Code Screens from the Management Menu, the first screen displays a dropdown box of DSS Units.
• Select a DSS Unit to display the Event Code Screen data. Columns include Synonym, Procedure, Location, Default Associated Clinic, Category and Status.

Figure 184: Event Code Screens Example

• The Event Code Table Report can be printed. When printing the report, the user will be prompted to choose Active, Inactive or All for the Clinic Status.
The Event Code Table Report can also be exported to Excel. The user will be prompted to choose Active, Inactive or All for the Clinic Status. The Excel spreadsheet columns included in this report are Synonym, Procedure, Location, Default Associated Clinic, Category and Status. The spreadsheet tab is “Event Code Table Export”.

Highlight the Procedure and click the Update button. The Update Event Code Screen form contains the following fields: DSS Unit, Category, Location, Procedure, Status, Procedure Synonym, Default Volume, Ask Reasons, and Default Associated Clinic.
• Select a Default Associated Clinic. The list box displays only active locations in the HOSPITAL LOCATION file (#44) whose type is “C” (clinic) and is a “count” clinic. In addition, if an Associated Clinic has non-conforming stop codes, the clinic will not be selectable.

4.4.7.1 Setting a DSS Unit to Send Data to PCE

Instructions to add an Event Code Screen:

Step 1. After selecting a DSS Unit from the dropdown box, click the Add button, or select the Add menu item from the Edit menu.

Step 2. At the appropriate dropdown boxes select the DSS Unit, Category (if enabled), Location (one/many/all), Procedure, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated Clinic.

Step 3. Click the OK button.

Figure 188: Adding an Event Code Screen

To Update an Event Code Screen:

Step 1. Click on an Event Code Screen from the list of Event Code Screens for the selected DSS Unit.

Step 2. Click the Update button, or select the Update menu item from the Edit menu.

Note:

• An error message appears if a user selects an Event Code Screen that has an inactive Associated Clinic. The user has the option to select an appropriate active clinic or to leave the Associated Clinic blank.
Step 3. **Update the Status, Procedure Synonym, Default Volume, Default Associated Clinic, and Ask Reasons.**

Step 4. **Click the OK button.**

**Figure 190: Update an Event Code Screen**

Instructions to Copy EC Screens to another DSS Unit

**Step 1. Highlight a DSS Unit that has an Active status.**
Step 2. Click the Edit menu and select the Copy EC Screens to another DSS Unit menu item.

Step 3. The Select a target screen appears. Select a target DSS Unit (usually newly created) from the dropdown list, then click the OK button.

Step 4. The Copy Event Capture Screen to <user-selected target DSS Unit> displays.

- The Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated Clinic fields can be modified on this screen.
- The DSS Unit, Category, and Procedure cannot be edited.
Note:
- The target DSS Unit is usually newly created by the user, but an existing DSS Unit may also be used.

Figure 194: Copy Event Code Screen

- Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated Clinic can be modified on this screen.

Note:
- If the DSS Unit is setup to not send records to PCE, the Default Associated Clinic is disabled.

Step 5. One, many or all Event Code Screens can be copied.
- To copy an Event Code Screen, review the field selections and make edits (if necessary). Click the OK button to save the changes, creating the copy. The next Event Code Screen will appear.
- To skip an Event Code Screen, click the Skip this EC Screen button. The next Event Code Screen will appear.
- When all needed Event Code Screens are copied, select the Close button to return to the Event Code Screen. All of the previous changes will be saved.

Note:
- If the user does not select a Location when copying an Event Code Screen, the record will not be filed and the following two error messages will appear:

Figure 195: Record Not Filed Error Message for Key Data Missing
Click the OK button on each error dialog to return to the Copy Event Code Screens form and enter a Location.

4.4.8 Inactivate EC Screen: Identify Inactive Multiple Event Code Screens

Before the User Starts

- Users with the ECMGR security key can select an EC Product Code (CPT Code, National EC Procedure Code or Local EC Procedure Code) and then display all of the DSS Units using the selected Product Code on the Inactivate Selected Event Code (EC) Screens for Given Procedure Code form.
- Choose to inactivate Event Code Screens by utilizing the checkboxes in front of each entry. The user can display and print a list of Event Code Screens inactivated for a chosen EC Product Code.

What the User Will See

- After clicking the Inactivate EC Screen button from the Management Menu, the Event Capture – Inactivate Selected Event Code (EC) Screens for Given Procedure Code form will be displayed.
- Checkboxes are available to the left of each entry. The user can select multiple checkboxes.

Figure 196: Inactivate Selected Event Code (EC) Screens for Given Procedure Code

Instructions for Inactivating Event Code Screen(s)

Step 2. The list shows all currently active Event Capture Product Codes. Use the checkboxes on the left side of the screen to select entries to be inactivated.

Figure 197: Entries Selected to be Inactivated

Step 3. Click the Apply or OK buttons to Inactivate.

Step 4. A confirmation message dialog will appear. Click the Yes button to inactivate the selection(s), or click the No button to return to the previous screen.

Figure 198: Confirmation Message Dialog for Inactivate Event Code Screens

Step 5. If the Yes button is clicked in response to the confirmation prompt, a listing of the Event Code Screens that were inactivated will be displayed.
Figure 199: Event Code Screens That Were Inactivated

There will be an option to Print this list of inactivated screens or click the OK button to return to the previous screen.

To verify that the Event Code Screens are inactivated, reenter the Event Code Product Code that was previously used. The list of DSS Units, Locations and Categories does not include the inactivated Event Code Screens.

Step 7. To verify that the Event Code Screens are inactivated, reenter the Event Code Product Code that was previously used. The list of DSS Units, Locations and Categories does not include the inactivated Event Code Screens.
5 Troubleshooting

5.1 Access Issues

Users need an Access Code and Verify Code obtained from their local Information Resource Management (IRM) staff to use the Event Capture GUI.

5.2 Log On Issues

Event Capture is usually accessed through a desktop shortcut which points to the installation location. Ask the local support staff for assistance.

If Event Capture launches and then disappears or is not responding, make sure the listed IP address is correct and not blocked by firewall software for the system with which it is communicating. Local support staff is available to assist with issues.

5.3 GUI Appears Distorted

If the ECS GUI display appears to be missing scrollbars, columns or rows, ensure that the screen resolution is set to a resolution of 1440 x 900 or greater.

5.3.1 Example of Setting the Screen Resolution to 1600 x 900

Step 1. Right-click on the desktop and select Screen resolution.

Figure 201: Desktop Menu Displayed After Right Click
Step 2. Select Normal size (1600 x 900) from the Resolution setting dropdown box and then click the OK or Apply button.

Figure 203: Menu Displayed After Selecting Screen Resolution Button (NVIDIA Graphics Card Menu)
## Appendix A: Acronyms

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADPAC</td>
<td>Automatic Data Processing Application Coordinators</td>
</tr>
<tr>
<td>CCOW</td>
<td>Clinical Context Object Workgroup</td>
</tr>
<tr>
<td>CHAR4</td>
<td>A 4-character code value of the associated clinic as specified from the DSS Clinics and Stop Code Worksheet File.</td>
</tr>
<tr>
<td>CM</td>
<td>Clinical Modification</td>
</tr>
<tr>
<td>CPRS</td>
<td>Computerized Patient Record System</td>
</tr>
<tr>
<td>CPT</td>
<td>Current Procedural Terminology</td>
</tr>
<tr>
<td>CSV</td>
<td>Code Set Versioning</td>
</tr>
<tr>
<td>DIAG</td>
<td>Diagnosis</td>
</tr>
<tr>
<td>DOB</td>
<td>Date of Birth</td>
</tr>
<tr>
<td>DSS</td>
<td>Decision Support System</td>
</tr>
<tr>
<td>Dx</td>
<td>Diagnosis</td>
</tr>
<tr>
<td>EC</td>
<td>Event Capture</td>
</tr>
<tr>
<td>ECALLU</td>
<td>Security Key - Event Capture All DSS Units</td>
</tr>
<tr>
<td>ECMGR</td>
<td>Security Key - Event Capture Manager</td>
</tr>
<tr>
<td>ECNORPT</td>
<td>Security Key - Event Capture No Reports</td>
</tr>
<tr>
<td>ECPATIENT</td>
<td>Event Capture Patient</td>
</tr>
<tr>
<td>ECPROVIDER</td>
<td>Event Capture Provider</td>
</tr>
<tr>
<td>ECS</td>
<td>Event Capture System</td>
</tr>
<tr>
<td>ECSPSH</td>
<td>Security Key - Event Capture Spreadsheet</td>
</tr>
<tr>
<td>FAQ</td>
<td>Frequently Asked Questions</td>
</tr>
<tr>
<td>FY</td>
<td>Fiscal Year</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>ICD</td>
<td>International Classification of Diseases</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>IPC</td>
<td>Inactive Person Class</td>
</tr>
<tr>
<td>IRM</td>
<td>Information Resource Management</td>
</tr>
<tr>
<td>IT</td>
<td>Information Technology</td>
</tr>
<tr>
<td>MAS</td>
<td>Medical Administration Service</td>
</tr>
<tr>
<td>MISC</td>
<td>Miscellaneous</td>
</tr>
<tr>
<td>N/A</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>NPCD</td>
<td>National Patient Care Database</td>
</tr>
<tr>
<td>O&amp;E</td>
<td>Observation and Examination</td>
</tr>
<tr>
<td>PCE</td>
<td>Patient Care Encounter</td>
</tr>
<tr>
<td>PIMS</td>
<td>Patient Information Management System</td>
</tr>
<tr>
<td>SHAD</td>
<td>Shipboard Hazard and Defense</td>
</tr>
<tr>
<td>Acronym</td>
<td>Full Form</td>
</tr>
<tr>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>SSN</td>
<td>Social Security Number</td>
</tr>
<tr>
<td>SW</td>
<td>Southwest</td>
</tr>
<tr>
<td>T&amp;TC</td>
<td>Section 508 Accessibility Testing and Training Center</td>
</tr>
<tr>
<td>VA</td>
<td>Veterans Affairs</td>
</tr>
<tr>
<td>VAMC</td>
<td>Veterans Affairs Medical Center</td>
</tr>
<tr>
<td>VAMROC</td>
<td>Veterans Affairs Medical and Regional Office Center</td>
</tr>
<tr>
<td>VistA</td>
<td>Veterans Health Information Systems and Technology Architecture</td>
</tr>
</tbody>
</table>
## Appendix B: Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Stop Code</td>
<td>The Stop Code that most closely represents the DSS Unit workload.</td>
</tr>
<tr>
<td>Category</td>
<td>Category provides Event Capture a common level to group associated procedures. Multiple procedures can be defined for each category.</td>
</tr>
<tr>
<td>CCOW</td>
<td>In the context of health informatics, CCOW is a Health Level-7 international standard protocol designed to enable disparate applications to synchronize in real time, and at the user interface level.</td>
</tr>
<tr>
<td>CHAR4 Code</td>
<td>A 4-character code value of the associated clinic as specified from the DSS Clinics and Stop Code Worksheet File.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost Center reveals which service is using this DSS Unit. Cost Centers are defined in detail in MP4-Part V, Appendix B of the Fiscal service cost manuals.</td>
</tr>
<tr>
<td>Conforming Clinics</td>
<td>Clinics that have stop codes in compliance with their restriction types. Stop codes are used in accordance to their assigned restriction types. Stop codes with restriction type 'P' can only be used in the primary stop code position. Stop codes with restriction type 'S' can only be used in the secondary stop code position. Stop codes with restriction type 'E' can be used in either the primary or secondary stop code position.</td>
</tr>
<tr>
<td>Count Clinic</td>
<td>A clinic for which workload entered is credited.</td>
</tr>
<tr>
<td>CPRS</td>
<td>Acronym for Computerized Patient Record System</td>
</tr>
<tr>
<td>CPT code</td>
<td>CPT codes are published by the American Medical Association. The purpose of the coding system is to provide uniform language that accurately describes medical, surgical, and diagnostic services.</td>
</tr>
<tr>
<td>CPT Modifier</td>
<td>CPT modifiers provide the ability to refine CPT procedure codes to better reflect procedures performed.</td>
</tr>
<tr>
<td>CSV</td>
<td>Code Set Versioning. The Health Information Portability and Accountability Act (HIPAA) mandated that applications using CPT codes, CPT modifiers, and diagnosis codes should allow users to select codes based upon a date that an event occurred.</td>
</tr>
<tr>
<td>DSS Unit</td>
<td>A DSS (Decision Support System) Unit defines the lowest level segment used for tracking hospital resources. These units can be a small work unit within a service or a large division within a service. Management at each facility is responsible for tailoring the DSS Units to fit its resource/cost reporting.</td>
</tr>
<tr>
<td>DSS Unit Number</td>
<td>This code is used for additional identification of DSS Units.</td>
</tr>
<tr>
<td>Event Capture</td>
<td>Software designed to provide management tools necessary in tracking procedures not entered in other VistA packages.</td>
</tr>
<tr>
<td>Event Code Screen</td>
<td>Event Code Screens are unique combinations of location, DSS Unit, category, and procedure that define patient procedures.</td>
</tr>
<tr>
<td>ICD-10-CM</td>
<td>International Classification of Diseases, Tenth Revision, Clinical Modification codes (based on the World Health Organization codes)</td>
</tr>
<tr>
<td>Location</td>
<td>Initializing the user site as a location, the Event Capture software recognizes the user facility as a valid location to enter Event Capture data.</td>
</tr>
<tr>
<td>MAS</td>
<td>Acronym for Medical Administration Service, which is now Patient Information Management System (PIMS).</td>
</tr>
<tr>
<td>Non-conforming Clinics</td>
<td>Clinics with stop codes that do not comply with the assigned stop code restriction types of P=Primary, S=Secondary and E=Either.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Non-count Clinic</td>
<td>A clinic for which there is no workload credited.</td>
</tr>
<tr>
<td>Ordering Section</td>
<td>The medical section ordering the patient’s procedure.</td>
</tr>
<tr>
<td>Parent Service</td>
<td>The controlling service for a DSS Unit.</td>
</tr>
<tr>
<td>PIMS</td>
<td>Patient Information Management System, formerly Medical Administration Service (MAS).</td>
</tr>
<tr>
<td>Procedure</td>
<td>A specific function performed on, or service provided to, a patient. Multiple procedures can be associated with a single category.</td>
</tr>
<tr>
<td>Procedure Reason</td>
<td>A method of generically grouping patient procedures to further describe the event, often giving patient or provider information.</td>
</tr>
<tr>
<td>Procedure Synonym</td>
<td>See Synonym</td>
</tr>
<tr>
<td>Provider</td>
<td>The provider of care performing the procedure. This provider can be a doctor, nurse, technician, or any designated team of medical professionals.</td>
</tr>
<tr>
<td>Reason</td>
<td>See Procedure Reason</td>
</tr>
<tr>
<td>Synonym</td>
<td>A locally recognized name or description for a procedure</td>
</tr>
<tr>
<td>T&amp;TC</td>
<td>Section 508 Accessibility Testing and Training Center</td>
</tr>
<tr>
<td>Volume</td>
<td>Volume is usually associated with the number of procedures performed. This field can also be used to track number of bed days, or to track time increments actually spent performing the procedure. (For example, if 15 minute increments is the unit, volume of 1 = 15 minutes, volume of 2 = 30 minutes, etc.)</td>
</tr>
</tbody>
</table>
Appendix E: Other ECS Package Management Information

Set up an ECS mail group in VistA to receive relevant ECS notifications. Contact IT to set up a VistA ECS Mail Group so more than one person receives ECS administrative messages.

Examples of ECS package administrative Email messages:

When a new ECS patch is released

Example 1

Subject: PATCH EC*2.0*XXX UPDATE TO EC NATIONAL PROCEDURE (#725) FILE[XXXXXXXX]

Date: MMM YYY 07:54:22 -0600 (CDT) 338 lines

From: <PROTECTED EMAIL ADDRESS> In 'PATCHES FOR DSS' basket, Page 1

---------------------------------------------

This patch is now in all TEST accounts and will be installed into PRODUCTION on TUE DATE by 8am CST. Post install information will be forwarded to DSS. Thank you for your review of this patch, if you have any questions call me. NAME PHONE.

TXT Created by YYYY, XXXX at <PROTECTED EMAIL ADDRESS> (KIDS) on Wednesday, MMM DD/YY at 12:18

=================================================================================

Run Date: MMM DD, YYYY      Designation: EC*2*XXX
Package: EC - EVENT CAPTURE      Priority: Mandatory
Version: 2       SEQ XXXX      Status: Released
Compliance Date: MMM DD, YYYY

=================================================================================

Associated patches: (v)EC*2*YYY    <= must be installed BEFORE 'EC*2*XXX'

Subject: UPDATE TO EC NATIONAL PROCEDURE (#725) FILE

Category:
- Other
- Routine

Description:

This patch addresses 1 issue:

1. Updates the EC NATIONAL PROCEDURE (#725) file: it adds 23 new procedure records, inactivates 16 existing procedure records, and updates names and codes for 49 others.

Associated NSR(s):
When an EC NATIONAL PROCEDURES file (#725) patch is loaded, a review of the EVENT CODE SCREENS file (#720.3) is performed. Event Code Screens, which have either inactive CPT or Event Capture Codes, or an Event Capture Code with an inactive "default" CPT code attached, are reported.
**Example**

From: <EMAIL ADDRESS PROTECTED>
Sent: Monday, MONTH DD, YYYY 9:00 PM
To: Package Manager
Subject: Event Code Screens to Review

Please forward this message to your local DSS Site Manager or Event Capture ADPAC.

A review of the EC EVENT CODE SCREENS file (#720.3) was done after installation of patch EC*2*XX which updated the EC NATIONAL PROCEDURE file (#725). This message provides the results of that review.

The EC EVENT CODE SCREENS file (#720.3) records indicated below point to an inactive record in the EC NATIONAL PROCEDURE file(#725) or to an inactive record in the CPT file (#81).

The user should use the Inactivate Event Code Screens [ECONACT] option to inactivate the Event Code Screen. If necessary, a new Event Code Screen can be created using a currently active CPT code or National Procedure.

The CPT procedure for the following Event code screen (XXX-X-X-XXXXX) is inactive --

Location: VAMC
Category: Treatment
DSS Unit: E-KINESIOTHERAPY-IP
Procedure: PROSTHETIC TRAINING (97528)

The CPT procedure for the following Event Code Screen (XXX-X-X-XXXXX) is inactive --

Location: VAMC
Category: Treatment
DSS Unit: E-KINESIOTHERAPY-IP
Procedure: PROSTHETIC CHECKOUT (97703)

The CPT procedure for the following Event Code Screen (XXX-XX-X-XXXXX) is inactive --

Location: VAMC
Category: None
DSS Unit: PSYCHOLOGY-IP
Procedure: PSYCHOLOGICAL TESTING (96100)

**Notes:**

After a patch updating file #725:

- Check for inactivated national EC Procedure Codes.
- Check for Event Code Screens with out-of-date EC Procedure Codes.

When an ECS User is terminated

(May inactivate national EC Procedure Codes and report any Event Code Screens with out-of-date Procedure Codes.)
Example 1

Sub: Removed Terminated Users from DSS UNIT Access [XXXXXXXX] MM/DD/YY @02:30 8 lines
From: EVENT CAPTURE in 'IN' basket. Page 1 "New"

Event Capture - Terminated Users removed from DSS UNITS

Total number of Terminated users: 1

DSS UNITS NAME of Terminated User Removed from DSS UNIT
----------------- -----------------------------------------------
CHAPLAINS Facility Staff Name

Enter message action (in IN basket): Delete//

Example 2

Event Capture - Terminated Users removed from DSS UNITS

Total number of Terminated users: 1

DSS UNITS NAME of Terminated User Removed from DSS UNIT
----------------- -----------------------------------------------
HCIC REFERRALS/STATS PROVIDER1, EC
HCIC STAFF PHONE PROVIDER1, EC
HCIC STAFF PHONE NOT W/PT PROVIDER1, EC
HCIC VA STAFF PROVIDER1, EC
SOCIAL WORK – INPATIENT PROVIDER1, EC
SOCIAL WORK – OUTPATIENT PROVIDER1, EC
SOCIAL WORK-C&P PROVIDER1, EC
SOCIAL WORK-GBH PROVIDER1, EC
SOCIAL WORK-PHONE NOT W/PT PROVIDER1, EC
## Appendix F: Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acronyms</td>
<td>123</td>
</tr>
<tr>
<td>Caveats and Exceptions</td>
<td>7</td>
</tr>
<tr>
<td>CCOW Single Sign-On</td>
<td>8</td>
</tr>
<tr>
<td>Changing User ID and Password</td>
<td>7</td>
</tr>
<tr>
<td>Continuity of Operations</td>
<td>2</td>
</tr>
<tr>
<td>Data Entry Menu</td>
<td>9</td>
</tr>
<tr>
<td>Data Flows</td>
<td>1</td>
</tr>
<tr>
<td>Data Imported and Ready for Upload</td>
<td>42</td>
</tr>
<tr>
<td>Document Orientation</td>
<td>1</td>
</tr>
<tr>
<td>Edit Cell Data on the Spreadsheet Upload Form</td>
<td>42</td>
</tr>
<tr>
<td>Event Capture Interface with CPRS</td>
<td>7</td>
</tr>
<tr>
<td>Event Capture Main Menu</td>
<td>2</td>
</tr>
<tr>
<td>Event Capture Online Documentation</td>
<td>7</td>
</tr>
<tr>
<td>Exit System</td>
<td>7</td>
</tr>
<tr>
<td>Getting Started</td>
<td>0</td>
</tr>
<tr>
<td>Glossary</td>
<td>125</td>
</tr>
<tr>
<td>ICD</td>
<td>27</td>
</tr>
<tr>
<td>Import a Regular Spreadsheet</td>
<td>39</td>
</tr>
<tr>
<td>Import a State Home Spreadsheet</td>
<td>40</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Logging On</td>
<td>1</td>
</tr>
<tr>
<td>Management Menu</td>
<td>94</td>
</tr>
<tr>
<td>Menu Bar for Specific Functions</td>
<td>4</td>
</tr>
<tr>
<td>Modify Column Order</td>
<td>43</td>
</tr>
<tr>
<td>National Service Desk and Organizational Contacts</td>
<td>3</td>
</tr>
<tr>
<td>Other Logic</td>
<td>47</td>
</tr>
<tr>
<td>Purpose</td>
<td>1</td>
</tr>
<tr>
<td>Reports</td>
<td>49</td>
</tr>
<tr>
<td>Reports Available to ECMGR Key Holders Only</td>
<td>70</td>
</tr>
<tr>
<td>Section 508 Compliance</td>
<td>2</td>
</tr>
<tr>
<td>Spreadsheet</td>
<td>39</td>
</tr>
<tr>
<td>Summary of the PCE Filing Process</td>
<td>128</td>
</tr>
<tr>
<td>System Configuration</td>
<td>1</td>
</tr>
<tr>
<td>System Summary</td>
<td>1</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Timeout Feature</td>
<td>8</td>
</tr>
<tr>
<td>Upload Imported Spreadsheet Data</td>
<td>44</td>
</tr>
<tr>
<td>User Access Levels</td>
<td>1</td>
</tr>
<tr>
<td>Using the Software</td>
<td>9</td>
</tr>
</tbody>
</table>